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Copyright 

Kev Medical Imaging  

QDOSE is a registered trademark of Telix Pharmaceuticals Ltd. All other trademarks belong to their 

respective owners. 

 

 

Used Symbols: 

 

Date of manufacture 
Year of manufacturing of the present software version 

 

Manufacturer 
Name and address of the manufacturer of the software 

 

Operating Instructions 
Every user is obliged to thoroughly read the user manual and to familiarize with the 
operation before using the software. 

 
Medical Device 
Indicates the item is a medical device 

 
Unique Device Identifier 
Indicates the unique device identifier information 
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1 Introduction 

1.1 Short Overview 

QDOSE is a software solution focused on targeted internal radiation therapy for treatment of oncological 

patients. It is used to process medical image data acquired during nuclear medicine imaging procedures 

such as planar scintigraphy, Single Photon Emission Computed Tomography (SPECT), Positron 

Emission Tomography (PET) as well as anatomical imaging methods such as X-ray Computed 

Tomography (CT) and Magnetic Resonance Imaging (MRI). It includes tools for two-dimensional (2D) 

and three-dimensional (3D) coregistration of multimodal data sets, drawing regions of interest, 

segmentation of organs, calculation of time-activity-curves, dose analysis and report generation. It is 

intended to be used by medical physicists and physicians in clinical routine and scientific investigations. 

1.2 Contact Details 

KeV Medical Imaging 

Sokratous 3, 

11147, Galatsi, Greece 

E-mail: qdose@kevimaging.gr 

Telephone: +30 2111154521 

Website: https://www.qdose.net 

1.3 Intended Purpose 

The medical device is intended to estimate the absorbed dose to organs and tissues based on 

intracorporal administration of radiopharmaceuticals and radio-labelled micro-spheres in oncology 

(cancer diseases). The medical device is not intended to be used for therapy planning. 

1.4 Intended Use 

The medical device QDOSE is intended to estimate the absorbed dose to organs based on intracorporal 

administration of radiopharmaceuticals in patients with cancer. At a whole organ level, this is done using 

a deterministic phantom-based model; in single organs, a spherical model or the Voxel S model are 

applied. The input for QDOSE is image data representing the biodistribution of an administered 

radionuclide or time activity curves or cumulated activities for organs. 

The results of QDOSE evaluations should not be used as stand-alone assessment of radiation exposure 

or assessment of internal radiation therapy. In the clinical environment different sources are available 

that should be included in every clinical process. 

Other non-QDOSE based methods of monitoring organ function and patient status should be available; 

QDOSE should not be the only tool for making clinical decisions. 

http://www.qdose.net/
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QDOSE allows the user to display multimodal medical image data limited to Computed Tomography 

(CT) data sets in axial slices, Magnetic Resonance Imaging (MRI) data sets in axial slices, Positron 

Emission Tomography (PET), Single-Photon Emission Computed Tomography (SPECT) and planar 

nuclear medicine images. 

QDOSE enables the user to perform measurements based on the data sets. Tools are available 

allowing coregistration of data sets, defining regions or volumes of interest (ROI/VOI) in data sets, 

performing fits of time-activity-curves and calculating cumulated activity. Cumulated activity values will 

be used to calculate absorbed dose based on deterministic models on whole organ level, or for single 

organs.  

The life span of QDOSE is 5 years starting from the signature date of the license agreement. 

1.5 Indication 

The indication for QDOSE is oncology (cancer diseases). 

1.6 Clinical Applications 

The application area of QDOSE is oncology (radiopharmaceutical cancer imaging and treatment). With 

QDOSE, the user can perform personalized dosimetry. Two clinical issues can be addressed with 

QDOSE: safety dosimetry and efficacy dosimetry. 

 

Safety dosimetry Efficacy dosimetry 

Dosimetry performed to determine organ 

absorbed doses and whole body effective dose 

to evaluate the overall treatment related risk for 

a patient.  

The clinical question is: 

“Is there too much dose to healthy organs?” 

Dosimetry performed to determine the dose 

received by a tumour to evaluate the treatment 

efficacy. 

 

The clinical question is: 

“Is there enough dose to the tumour?” 

 

With QDOSE, the trade-off between safety and efficacy can be analysed for the following applications. 

 

1.6.1 Application 1: Dosimetry of Systemic Internal Radiation Therapy 

QDOSE can be used to perform post-treatment dosimetry of systemic internal radiation therapy. 

Nuclear medicine image data (planar scintigraphy images and/or SPECT or PET) at multiple time points 

(minimum 2 time points) after administration of a radiopharmaceutical to a patient have to be available. 

Image data sets can be coregistered and ROIs/VOIs can be drawn and segmentations can be 

performed. For each segmentation over multiple time points different curve fit models can be used to 
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calculate the cumulated activity. Based on the cumulated activities for the segmentations the absorbed 

doses as well as effective doses can be calculated. 

1.6.2 Application 2: Dosimetry of Diagnostic Radiopharmaceuticals 

QDOSE can be used to perform dosimetry of diagnostic radiopharmaceuticals. Nuclear medicine image 

data (planar scintigraphy images and/or SPECT or PET) at multiple time points (minimum 2 time points) 

after administration of the diagnostic radiopharmaceutical to a patient have to be available. Image data 

sets can be coregistered and ROIs/VOIs can be drawn, and segmentations can be performed. For each 

segmentation over multiple time points different curve fit models can be used to calculate the cumulated 

activity. Based on the cumulated activities for the segmentations the absorbed doses as well as effective 

doses can be calculated. The doses can be extrapolated to other nuclides and activities. 

1.6.3 Application 3: Dosimetry of Selective Internal Radiation Therapy 

QDOSE can be used to perform dosimetry of selective internal radiation therapy (treatment of liver 

metastases). Nuclear medicine image data (SPECT or PET) have to be available. A pre-therapeutic 

image (e.g. 99mTc-MAA scans) as well as a post-therapeutic 90Y PET image can be used. It is possible 

to only evaluate pre-therapeutic images or post-therapeutic images or both. Image data sets can be 

coregistered and ROIs/VOIs can be drawn and segmentations can be performed. The absorbed doses 

for the segmented regions can be calculated for the pre-therapeutic data set and the post-therapeutic 

data set. Extrapolation to other values of administered activity is possible. 

1.7 Intended User 

QDOSE is intended to be used by trained medical professionals including radiologists, nuclear medicine 

physicians, and medical physicists. The user must have experience in using medical imaging software 

and needs an understanding in the concept of dosimetry. The user requires training by qualified 

personnel in order to use QDOSE. 
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1.8 Information about Product Safety and Residual Risks 

The medical device poses the risk, that wrong dose values lead to clinical decisions that can harm the 

patient. The professional duty to the patient in providing healthcare services lies solely with the 

healthcare professional providing patient care services. The user takes full responsibility for the use of 

information provided by QDOSE in patient care. The use of the product in no way is intended to replace 

or substitute for professional judgement. 

The following information must be followed by the user for a safe clinical use of QDOSE. 

 

1.8.1 Safety Information 

The safety information for QDOSE is indicated in the following way: 

 

 CAUTION 

Caution description. 

A CAUTION indicates a hazardous situation which, if not avoided, leads to a software output that 

could result in minor or moderate injury. 

 

Please read the following safety information carefully before using the software. 

 CAUTION 

The Activity Prediction tool is not intended to be used clinically. 

According to the intended use of QDOSE, the Activity Prediction tool for SIRT mode must not be 

used for treatment planning. The Activity Prediction tool is only for research purposes. Depending 

on the calculation method and the input values, there may be wide differences between the activities 

calculated by the different methods. The planning of treatment should not be performed based on 

the displayed values. Instead, the instructions of the manufacturer of the spheres should be used. 

 

 CAUTION 

Incorrect input image data causes incorrectly calculated dose values. 

All calculated values depend on the quality of the input data. It is the user’s responsibility to check 

for completeness and correctness of the image data. The image data must be suitable to perform 

dose calculation. The user should always check available image data for completeness and 

correctness before performing analysis steps. 
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 CAUTION 

Voxel S dosimetry of lung, bone or bone lesions results in incorrect values. 

Voxel S kernels are only valid for soft tissue. Voxel S dose calculations for other tissues such as 

bone or lung are not valid. Voxel S methodology should not be used for lung, bone, bone metastases 

or other lesions in the bone. Furthermore, the user has to decide how meaningful Voxel S dose 

calculations are for their specific image data, as the activity distribution used as base for calculation 

may be incorrect due to partial volume effect. 

 

 CAUTION 

Dose calculation of alpha emitters underestimates the dose. 

Dose calculations for radiopharmaceuticals with alpha emitters are only performed for the parent 

nuclides. Daughter nuclides in a decay chain are not accounted for. The user should be aware that 

dose estimation for radiopharmaceuticals with alpha emitters may be too low. 

 

 CAUTION 

QDOSE should be used in a secure network.  

IT security is in the responsibility of the user. 

 

 CAUTION 

Unauthorised persons can access sensitive data. 

Unauthorised access is prevented by user authentication (login) and authorization (roles and rights) 

measures. In addition, since QDOSE version 1.2.4 the databases are encrypted to prevent 

unauthorised access to the data by third parties. Users should upgrade old databases for encryption 

when proposed by the program. 

Still, the software should be used in an environment where user access is regulated by user 

accounts at the level of the operating system. No responsibility is taken for the access to sensitive 

data by unauthorised persons deliberately bypassing the security measures. It is in the user’s 

responsibility to guarantee data protection strategies. 
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 CAUTION 

QDOSE is not intended to store data permanently.  

It is the user’s responsibility to perform backups of data and to assure data integrity. The user has 

to make sure all relevant data that needs to be archived for a defined period of time is saved in 

appropriate location.  

 

 CAUTION 

Conversion of organ names after upgrade may result in different dose calculations. 

New names will be used for some organs in version 1.1.4 of QDOSE and following versions. If a 

case created in a previous version of QDOSE is opened, the organ names in that case may have 

changed in version 1.1.4 or higher. If a case from an older version of QDOSE is loaded with ODOSE 

version 1.1.4 or higher, the user should check the available organs and the corresponding 

segmentations. The user can create new organs if necessary or change the segmentation of the 

organs. 

 

 CAUTION 

User defined organ names may not be included in dose calculation. 

If the user creates organs by defining own names, the cumulated activity of those names may not 

be considered for model-based dose calculation (IDAC-Dose). It is recommended to use only organ 

names that are in the predefined organ list. 

 

 CAUTION 

Incorrect coregistration can lead to false segmentation. 

The coregistration results depend on the quality of the image data. The user must check the 

coregistration result for each time point. The user can adjust the display of the data sets as well as 

the overlay of the reference and 2:nd data set in order to compare the alignment between the data 

sets. 

The results from copying ROIs or VOIs to other time points depend on the quality of the registration 

between the data sets. After copy and paste of ROIs/VOIs, the ROIs/VOIs may not contain the 

organ or region at all time points due to local misalignment between the time points. The position of 

the ROI/VOI must be checked by the user for each organ and time point prior to performing further 
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processing steps. If the positions of the ROIs/VOIs are insufficient, the user can draw ROIs/VOIs 

on each time point separately or edit ROIs/VOIs manually after copying to the time points. 

 

 CAUTION 

Incorrect organ segmentation results in incorrect dose values. 

The dose calculation is based on the activity in the segmented regions. Phantom-based dose 

calculation is based on the assumption that the activity arises from the whole organ. If only a part 

of the organ is segmented or the segmentation also includes other organs, the calculated doses 

may be incorrect. The user should only include the organ corresponding to the selected organ name 

in the segmentation. 

 

 CAUTION 

Incomplete or incorrect images result in incorrect dose values. 

All calculated values depend on the quality of the input data. The input image data must be suitable 

to perform dose calculation. The user must check the image quality prior to any analysis. The user 

should always check available image data for completeness and correctness before performing 

analysis steps. 

 

 CAUTION 

Incorrect quantified SPECT and PET image data result in incorrect dose values. 

SPECT and PET images are assumed to be quantified in units of Bq/ml. Quantitatively 

reconstructed SPECT and PET images can be directly imported. In case SPECT or PET images 

are not reconstructed quantitatively, a scaling factor must be provided by the user and entered for 

each data set. Scaling factors for quantitative data may be stored in private tags of the DICOM 

image header depending on the manufacturer. It is the user’s responsibility to check for the scaling 

factor. Please ask the manufacturer of your imaging system for further information. 

 

 CAUTION 

Incorrect acquisition time result in incorrect dose values. 

For data sets with multiple files the acquisition time of the first (earliest) slice is used as acquisition 

time. Acquisition time can be adapted in Edit Case. 
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 CAUTION 

Changing nuclide will reset added organs with precalculated Ã. 

Additional organs with precalculated Ã can be added in Dose Analysis window. The cumulated 

activity of those organs will be reset after changing the nuclide in Edit Case or in Dose Analysis. 

Always check the input to IDAC-Dose calculation by clicking the button Input data. 

 

 CAUTION 

Simultaneous changes to the users’ database might be lost 

The users’ database should only be accessed by one admin at a time. Simultaneous changes to 

the user management might lead to data loss on the user management that was opened as second 

instance. Save changes immediately and do not leave the user management open for a longer 

period of time. 
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1.8.2 Important Advice 

Important advice for QDOSE is structured as described here: 

NOTICE 

Notice description. 

A NOTICE is used to address practices not related to physical injury. 

 

Please read the following important advice carefully before using the software. 

NOTICE 

Always check data for plausibility. 

User actions affect the results of the software. All displayed information including images, 

segmentation results, registration results, time-activity-curves and dose values should be checked 

for plausibility by the user. 

 

NOTICE 

Source organ naming influences the dose calculation. 

IDAC-Dose 1.0 and IDAC-Dose 2.1 use defined organs as input. It is highly recommended to use 

the predefined organ names from the organ list when creating a new organ. For IDAC-Dose 1.0 and 

IDAC-Dose 2.1 dose calculation, the user should check the input data by clicking on the button 

Input data in the tab ICRP – IDAC-Dose in the dose analysis step. 

 

NOTICE 

QDOSE dose values before version 1.1.4 will be reset. 

The user should be aware, that dose calculations of cases, which were created with a QDOSE 

version prior to 1.1.4, will be reset. In order to document the dose calculation performed with an 

older QDOSE version (prior to version 1.1.4), please export a report and/or CSV (comma-separated 

values) file of the case prior to updating to the new QDOSE version. 
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NOTICE 

The default organ list differs between cases. 

The user can select the organs that are displayed in the default organ list when creating new organs. 

Changes in the default organ list, which can be edited in the window QSettings using the button 

Edit Organs … to open the window PreDefinedOrgans, will only affect new cases. If the user 

opens other cases, the default organ list may differ from the current setting. 

 

NOTICE 

Source organs of OLINDA EXM 1.0, IDAC-Dose 1.0 and IDAC-Dose 2.1 have different 

definitions. 

In some cases, OLINDA EXM 1.0 and IDAC-Dose 1.0 and IDAC-Dose 2.1 use different definitions 

of organs.  

• The organs "Right colon contents (RC)", "Left colon contents (LC)" and "Rectosigmoid colon 

contents (RSC)" are used by IDAC-Dose 2.1 and are the default organs in QDOSE. If any 

or all of these source organs exist, the OLINDA source organs "ULI contents" and "LLI 

contents" will be created and Ã will be calculated according to:  

o ULI = RC + 0.478873 · LC  

o LLI = RSC + 0.521127 · LC 

• If organs "Uterus/cervix" and "Uterus" both exist, the OLINDA export will use "Uterus" and 

will ignore "Uterus/cervix".  

• If organ “LLI” exists, but also “RC” and/or “RSC”, OLINDA export will use the organ “LLI” 

and will not calculate Ã based on “RC” and “RSC”.  

• If organ “ULI” exists, but also “RC” and/or “LC”, OLINDA export will use the organ “ULI” and 

will not calculate Ã based on “RC” and “LC”. 

The user should check which organs were used for model-based dose calculation by clicking the 

button Input data in the window Dose Analysis. 

 

NOTICE 

Display of image data influences image processing. 

The user has the responsibility to ensure the quality of the monitor and ambient light conditions. 

 



   

   

QDOSE v1.2.12, User Manual  Page 17 of 123 

NOTICE 

Computer hardware influences performance. 

The performance of specific functions may vary for different hardware. No responsibility is taken for 

the execution time of specific functions. 
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2 Getting Started 

Description of system requirements, installation process and how to set up QDOSE for first use. 

2.1 System Requirements 

• Windows 10 (64 bit), Windows 11 (64 bit) 

• Memory of 8 GB; at least 12 GB are recommended for 3D coregistration 

• Hard drive with at least 5 GB free space for the application. Database space depends on the 

number of cases and image data. 

• Intel Core i-5 processor or higher  

• Screen resolution minimum 1600x900 pixel  

• Dedicated graphics card with OpenCL support (e.g. NVIDIA from generation GT200 or ATI from 

generation HD 4730, 5830, 6930, 7730, R7 240) for improved performance for 3D registration. 

• PDF viewer (for viewing Report and User Manual) 

 

2.2 Requirements IT Infrastructure 

 CAUTION 

QDOSE should be used in a secure network.  

The IT security of the environment where QDOSE is operated is in the responsibility of the user. 

 

 CAUTION 

Unauthorised persons can access sensitive data. 

Unauthorised access is prevented by user authentication (login) and authorization (roles and rights) 

measures. In addition, since QDOSE version 1.2.4 the databases are encrypted to prevent 

unauthorised access to the data by third parties. Users should upgrade old databases for encryption 

when proposed by the program. 

Still, the software should be used in an environment where user access is regulated by user 

accounts at the level of the operating system. No responsibility is taken for the access to sensitive 

data by unauthorised persons deliberately bypassing the security measures. It is in the user’s 

responsibility to guarantee data protection strategies. 
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QDOSE is a standalone software that is not intended to be used with other devices or in an IT network. 

However, the user must provide a system that is secure. The following requirements must be provided 

by the user: 

• Microsoft Windows operating system (Windows 10 or 11) with current safety update status 

• Established firewall and established anti-virus application. 

If a case was corrupted due to a failure to maintain security, the case might not be loadable anymore. 

 

2.3 Installation 

The installation of QDOSE is intended to be made by the user or an IT administrator. For installation of 

QDOSE please follow these instructions: 

1. Run the provided QDOSE installer and follow the installation instructions.  

Note: During the first installation and if not already present, the MATLAB Runtime Compiler will 

be automatically installed on your system. Therefore, administration privileges are required. 

2. Start the application QDOSE.exe via the program menu or using the QDOSE icon. 

In case, the system (hardware or software) is changed, QDOSE needs to be installed again on the 

system, following the instructions above. 

 

2.4 License Activation 

If QDOSE does not find a valid license, it will prompt the user to import a valid license. In order to 

activate QDOSE with a valid license, follow these steps: 

1. Please export the fingerprint file using the button Export Key. 

2. Save the file on your file system and send it to QDOSE Support: qdose@kevimaging.gr 

3. QDOSE Support will generate a valid license and send it back to you. 

4. QDOSE Support will send the one-time token in a separate mail. 

5. Start QDOSE and click on Import License.  

6. Select the license file from your file system. After import and accepting the End User License 

Agreement and Data Processing Agreement, a Login window will appear. 

7. Enter the super admin credentials with the one-time token and confirm: 

• User name: SuperAdmin 

• Password: <token from QDOSE Support> 

8. The window QSettings will open. There, select an archive path as described in chapter 2.7. 

9. Save the settings. Next, the Patient Browser will open. 

10. Create and manage users and administrators as described in chapter 14. 
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In case a license has expired or a new license is required, QDOSE will prompt the user to import a new 

valid license. Follow the steps 1 to 9 again to activate a new license. A new one-time token will be 

necessary again. 

In case the one-time token was consumed, and no QDOSE user or QDOSE administrator can access 

the program anymore, a new license with a new one-time token must be requested by the user. Please 

follow again steps 1 to 9. 

 

2.5 Instructions for Use 

The User Manual contains the instructions for use and technical description of the medical device 

QDOSE. They are supplied in electronic form instead of in paper form. The User Manual is available 

for download in different languages via QDOSE website (www.qdose.net) (using the country password 

provided upon product commissioning) and upon request from our support centre.  

Please contact qdose@kevimaging.gr to get the current version in your local language. 

A printed hardcopy (paper format) of the QDOSE User Manual can be requested for free by contacting 

the manufacturer, see contact information in chapter 1.2. 

It will be delivered within 7 calendar days after receiving the request. 

 

2.6 Start-up and Shutdown 

To start the application, double click on the QDOSE icon or start it from your program menu. 

 

To safely shut down the application, save your current work if necessary and close the software via 

File > Quit or via closing the window. 

 

2.7 Archive path 

 CAUTION 

QDOSE is not intended to store data permanently.  

It is the user’s responsibility to perform backups of data and to assure database availability. The 

user has to make sure, all relevant data that needs to be archived for a defined period of time is 

stored at an appropriate location. 

 

 CAUTION 

QDOSE database is not intended to be used by several users in parallel. 

http://www.qdose.net/
mailto:qdose@kevimaging.gr
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The database must only be accessed by one QDOSE instance at the time. If several users access 

the same database in parallel, data might be lost. 

 

 

 CAUTION 

Encryption of database recommended. 

Since QDOSE version 1.2.4 there is the possibility to encrypt the archive to protect the patient health 

data from unauthorised access outside of QDOSE. New archives are automatically encrypted. 

Archives created with versions prior to version 1.2.4 were encoded in a proprietary format and will 

be checked and the user can decide to encrypt them. This procedure is recommended to protect 

sensitive data. 

 

The archive path defines the location of the database where the QDOSE cases are stored. Please 

choose the desired database location by following these instructions: 

1. In the window Patient Browser click on the button File in file menu bar. 

2. Select Settings to open the window QSettings 

3. Browse through the file system to select an archive path by clicking on the button Browse or 

enter an existing archive path manually. 

4. Click on the button Save to save the settings. 

The user can create several databases (folders on the filesystem), but only one database can be 

selected in the software. A backup of the database can be created by copying the folder on the file 

system. By selecting this copy as archive path, the backup can be accessed. 

 

2.8 Software Updates 

Software updates and upgrades are issued by the manufacturer as new installation files. Please follow 

these steps to update the software program: 

1. Download the new installation file as explained by QDOSE support. 

2. Perform the installation as explained in chapter 2.3. 

3. A new version of QDOSE requires a new license key. The user has to activate a new license 

key as described in chapter 2.4. 

4. The successful installation as well as the license are validated. The user can check the installed 

version with the help of the version number displayed under Help > About.  
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2.9 Decommissioning 

 CAUTION 

QDOSE databases must be carefully disposed by the user. 

The database(s) created and used by the user for QDOSE are not deleted. It is the user’s 

responsibility to safely decommission or dispose the data or databases, which might contain 

sensitive data Since QDOSE version 1.2.4 all database are encrypted to protect patient health data. 

Old databases were encoded in a proprietary format and should always be upgraded for encryption, 

see Notice in section 2.7. 

 

In order to decommission the application safely after it is no longer used, the software shall be 

deinstalled from the system. The deinstallation can be done using the program manager or by right-

click on the application icon. 
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3 QDOSE Concept 

This section describes the concept behind QDOSE and how it can be utilized for the calculation of 

internal radiation doses. 

3.1 What is QDOSE? 

QDOSE is a stand-alone software solution for calculating internal radiation dose distribution. QDOSE 

provides the following systemic workflows (Figure 1): 

 

Figure 1: Systemic workflows: Planar, Hybrid, 3D. 

 

3.1.1 Planar Workflow 

In planar mode, multiple time points (TP) of planar scans (using conjugate plane view) are the base of 

dose calculations using the quantitative methodology according to MIRD pamphlet No. 16 (Siegel et al. 

1999).  

3.1.2 Hybrid Workflow 

In hybrid mode, QDOSE performs dose calculations using multiple time points of conjugate view 

imaging (as in planar) for calculation of the kinetics, while one quantitative SPECT/CT is used to 

calibrate the time-activity-curve (TAC) according to MIRD pamphlet No. 16, Section IV.B SPECT (Siegel 

et al. 1999) and MIRD pamphlet No. 23, Section Hybrid Planar/SPECT Methods (Dewaraja et al. 2012) 
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The activity distribution within an organ is provided by Voxel S dose calculation. The volumetric scan 

can also be used for calculation of the organ volume and subsequently for the organ mass for more 

patient-specific dose calculation. 

3.1.3 Volumetric (3D) Workflow 

QDOSE volumetric mode uses multiple time points of volumetric images (at least two) for calculation of 

organ kinetics as well as organ volume/mass and activity distribution. All calculations are hence 

performed using the 3D data. 

3.1.4 SIRT/MAA Workflow 

This mode is used for Selective Internal Radiation Therapy (SIRT) for: 

• Post-treatment dosimetry using a single time point 90Y PET/CT or Bremsstrahlung SPECT/CT 

• Pre-treatment dosimetry using 99mTc-MAA SPECT/CT 

 

3.2 Basic workflow  

QDOSE provides a workflow which guides the user through the steps required to perform the chosen 

calculation method as described above. Even though QDOSE promotes a certain workflow, the 

workflow is dynamic. The user can go back and forth anytime and redo previous steps. 

The generally required steps are displayed in the flowchart and outlined below (see Figure 2). 

 

Figure 2: Internal dosimetry steps. 

 

• Case creation: A case is the data container keeping all data for one radionuclide therapy or 

diagnostic dosimetry evaluation together, e.g. it contains all data for one dose cycle of 

radionuclide for one patient.  
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• Upload of images: Depending on the selected workflow, images can be selected either one-by-

one through the menu Data Import or bundled using the menu option Multiload for fast data 

loading. 

• Planar (2D) coregistration: Registration of planar images (planar and hybrid workflow only) to 

accelerate ROI drawing (next step). 

• Region of interest (ROI) drawing: To define boundaries of different organs. There is no need to 

exactly delineate the organ, as organ segmentation will be done in the next step. The following 

two organs are handled separately:  

o Total body: Definition of the organ Total Body for calculation of the organ Remaining 

Body. QDOSE requires an organ Total Body to exist in order to provide access to the 

next step, in which the whole body (WB) is used for activity calibration of the planar 

images. 

o Vial: An organ called Vial can be defined for a vessel containing a portion of the same 

radionuclide as the injected one. The reference vial can be coregistered separately to 

the transmission image. This is necessary for proper attenuation correction, if the 

reference vial is chosen for the activity calibration. 

• ROI segmentation: Each organ is segmented based on a reference time point, within the 

boundary defined in the ROI drawing step. The segmented area (organ) is further used for a 

second organ-based coregistration to compensate for organ movements.  

• Volume of interest (VOI) segmentation: If volumetric data are uploaded, the CT and NM data 

(SPECT or PET) can be fused for visualization purpose. 3D boundaries can be defined and 

volume and activity within each boundary can be calculated. QDOSE provides two separate 

VOIs for calculating the anatomical volume on the one hand side and the activity volume on the 

other hand side. This is based on the assumption that the VOI containing the activity should be 

larger than the VOI of the anatomical volume. The reason is the inferior resolution of the NK 

image, which results in partial volume effect. 

• 3D coregistration: Since multiple volumetric time points can be loaded simultaneously, QDOSE 

also provides a volumetric coregistration tool. The coregistration tool enables coregistration of 

different time points (based on the CT images) or within each time point (CT-NM). 

• Dose calculation: For this step, QDOSE provides tools for: 

o Mono-, bi- or tri-exponential curve fitting for TACs 

o Calculation of cumulated activity 

o Safety dosimetry using phantom-based dose calculation (IDAC-Dose 1.0 or IDAC-

Dose 2.1 software (Andersson et al., 2017), export case file to OLINDA/EXM 1.1 

(Stabin et al., 2005)), spherical model or Voxel S 
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o Efficacy dosimetry using Voxel S or spherical model 

o Dose prediction (activity extrapolation and/or nuclide replacement) 

o Dose calculation for SIRT for post-treatment dosimetry (90Y) or pre-treatment dosimetry 

(99mTc-MAA)  

• Report generation: Reports can be generated in PDF format using QDOSE report generator. 
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4 Settings 

The window QSettings allows editing general settings for the use of QDOSE. 

The window QSettings can be opened by using the file menu bar in the window Patient Browser by 

clicking on File > Settings. The following settings can be accessed and edited (see Figure 3): 

 

Figure 3: Window QSettings. 

 

• Paths:  

o Archive path: In the archive path the case database is stored. This path can be 

changed in order to create another QDOSE case database. 
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o Users DB path: In the users DB (database) path the database for the user 

management is stored. By default, the users’ database is created under 

‘C:\ProgramData\QDOSE’. This path can be changed to another database file (*.db7) 

in case of multiple QDOSE installations. See chapter 14.2.5 for more details how to 

setup the user management for multiple QDOSE installations 

• License: The fingerprint of the system and the current license is displayed. 

o Clicking on the button Display shows detailed license information. 

o Clicking on the button Import enables selecting and importing a license file. 

• Support: The web address of the QDOSE support homepage is displayed and can be edited. 

• Debug: Defines the level of debug information that is printed in the log file. 

• Application: Parameters for different processing steps are defined here. 

o Liverator timeout (s): The timeout in seconds for which the automatic AIT-Liverator 

segmentation algorithm cancels the processing. 

o Display margin (pxls): The margin in pixels that is additionally shown around the 

drawn boundary in the window ROI Segmentation. 

o Paste tolerance (mm): The acceptable tolerance in mm for copy and paste of VOIs 

between different time points. 

o Session Timeout (min): The period of a session after which the current user is 

automatically logged out. After timeout, the access to the program is declined. The user 

has to authenticate again to grant access to the software again. 

o Mirror Posterior Image: Select if the posterior planar image should be displayed 

mirrored. 

o Edit organs: Dialog window for defining the organs that are displayed by default in the 

window Create Organ 
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5 Patient Browser 

The window Patient Browser offers the possibility to overview all cases in the database, manage 

cases (create, delete, edit), handle image data (load and edit) and start the analysis steps 

5.1 Jump Start 

The window Patient Browser is the QDOSE main screen to manage cases, launch different tools or 

import the required image data for dosimetry evaluation. All tools can be accessed via the file menu 

bar. An overview of the cases is displayed in the table in the window center (see Figure 4). 

 

 

Figure 4: Window and main screen Patient Browser. 

 

1. Create a case with information about nuclide, injected activity, injection date and time as well 

as the desired dosimetry workflow (Default, SIRT/MAA) by clicking on File > New Case. An 

empty case will be created and displayed in the window Patient Browser. 

2. Select the case and import image data by either right-clicking on the case in the table or using 

the file menu option by clicking on File > Data Import.  

Note:  

• The option Multiload will scan through the user-selected root directory and display an 

overview of all DICOM images found in that specific folder and its subfolders. 

• If using the option Multiload, once scanning is completed, press CTRL and click on the 

desired series to select/unselect the images (planar, blank, transmission, SPECT/PET, CT, 

MR) that need to be loaded into your case. 



   

   

QDOSE v1.2.12, User Manual  Page 30 of 123 

• Once all required series are imported, the window Multiload will prompt the loading result 

for each series, either successful or failed with a description. This window can then be 

closed. 

• Alternatively, images can be loaded via a modality-specific loading dialog by clicking on 

File > Data Import. Options are: Planar Joined ANT-POST or Planar Separate ANT-

POST, SPECT, PET, CT. E.g. the option SPECT allows selecting a specific SPECT series 

in the file system for upload. 

3. To check/edit loaded image data for that specific case, click on File > Edit Case. 

Note:  

• For planar data, the energy window for analysis and the nuclide used in the transmission 

and blank scan (for attenuation correction) can be selected. The type of image can also be 

changed in column Type from the default Emission (EM) to Transmission (TR) or Blank 

(BL). This step is required, as all planar images are initially uploaded as emission images 

in the window Multiload. 

• For SPECT data, the scaling factors to convert pixel values to Bq/ml can also be defined in 

the columns Image Unit and Scale F. 

4. For a selected case, the different analysis steps can be started from the Patient Browser using 

the file menu by clicking on Analysis > Dose Analysis or right-clicking on the selected case 

and selecting Dose Analysis. 

Note: The case data is not saved until manual saving by clicking on File and select Save Case 

in the file menu or by pressing the shortcut CTRL + S. 

Shortcuts 

• CTRL + S:  Save case (image data and evaluation steps and results) 

• Right-click:  opens the context menu of the selected case to load data or access the specific 

evaluation steps. 

• CTRL + Click:  Add/remove item to/from the current selection in the window Multiload. 

 

5.2 Menu Bar Items 

The following options are available in the file menu bar in the window Patient Browser: 

5.2.1 File 

• New Case: Creates a new case. 

• Edit Case: Opens a window to view and handle case related image data and case information 

(see 5.4) 
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• Save Case: Saves current status of the case including regions and evaluations performed. 

• Save Case As: Saves a copy of the current case with different case name. 

• Delete Case: Removes the selected case. 

• Import Case: Imports a QDOSE case from the file system. 

• Export Case: Exports the selected case with all information to the file system. 

• Settings: Opens the QDOSE Settings. 

• Quit: Quits QDOSE. 

 

5.2.2 Data Import 

 CAUTION 

Store input image data in a secure place. 

DICOM images that are intended to be used as input for QDOSE should always be stored in secure 

place that prevents unauthorised access to sensitive data (patient health data). Storage mediums 

should either be encrypted or stored in a Picture Archiving and Communication System (PACS) and 

access to these data should be controlled. After import of image data, QDOSE will store an 

encrypted copy of the input images in its database in its proprietary format (not DICOM). DICOM 

image data that is no longer used, should be deleted from the storage medium. 

 

 CAUTION 

Preview and report images are not for clinical review. 

Preview images and images in the report are only for data set identification purpose. They must not 

be used for diagnostic purposes of any kind. 

 

 CAUTION 

Incomplete or incorrect image data results in incorrect dose values. 

The option Multiload can identify associated planar scintigraphy images, whose anterior and 

posterior views are stored in separate files. In that case, the separated files are loaded jointly as 

one image time point. The user should check in the window Edit Case, whether the anterior and 

posterior views are correctly associated to ANT and POST, respectively. If not, the anterior and 

posterior images can be swapped. 
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NOTICE 

Invalid image data results in incorrect dose values. 

QDOSE only supports anterior and posterior planar scintigraphy images, SPECT, PET, CT in axial 

slices and MRI in axial slices (only morphological, T1, T2 weighting). Unsupported modalities or 

image data may result in incorrect function of the software. Unsupported data sets may be rejected 

during loading. The user should always check the available image data for completeness and 

correctness before performing analysis steps. 

 

• Multiload: Dialog box to scan through folders and subfolders for DICOM series. It only allows 

loading of relevant DICOM data types (planar scintigraphy images, SPECT, PET, CT (axial 

slices), MRI (axial slices)). 

• Planar Joint ANT/POST: Dedicated dialog for loading planar data where ANT and POST views 

are stored within one file. 

• Planar Separate ANT/POST: Dedicated dialog for loading planar data where ANT and POST 

views are stored in separate files. 

• SPECT: Dedicated dialog for loading SPECT data. 

• PET: Dedicated dialog for loading PET data. 

• CT: Dedicated dialog for loading CT data. 

5.2.3 Analysis 

• 2D Coregistration: Opens a window for coregistration of planar data. 

• ROI Drawing: Opens a window to define (draw) boundaries on planar data. 

• ROI Segmentation: Opens a window to segment and coregister organs on planar data in the 

predefined boundaries. 

• 3D Coregistration: Opens a window for volumetric coregistration between time points and 

within each time point. 

• VOI Segmentation: Opens a window to define 3D organ boundaries and segment within the 

boundaries. 

• Dose Analysis: Opens a window for curve fitting and dose calculation. 

5.2.4 Report 

• Generate Report: Generates a report for the selected case. 

• Notes: Opens the notes dialog to view or add case related notes. 
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5.2.5 Tools 

• Activity Prediction: Activity calculation tool for SIRT. 

• Change password: Dialog to change the current user’s password. 

• Change user: Dialog to change the current user by re-authentication. 

• User Management: Opens a window to manage users and roles. 

 
5.2.6 Help 

• QDOSE Help: Opens the QDOSE user manual. 

• About: Opens the about dialog with version, unique device identifier (UDI) and support contact 

information. 

• License: Displays the modules and nuclides available in the current license. 

• End User License Agreement: Displays the terms and conditions for using the QDOSE 

license. 

• Data Processing Agreement: Displays the terms and conditions of Data Processing. 

• Copyright: Opens the copyrights statement window. 

• Export log file: Creates a log file at a specified file path. 

• Support: Opens the support website to raise support requests. 

• User Manual: Opens the QDOSE user manual. 

 

5.3 Create Case 

NOTICE 

The calibration method for planar images influences the dose calculation. 

For the activity/sensitivity calibration of planar images, the user can define whether to use a whole 

body (WB) calibration or Vial calibration. 

 

A case is the data container keeping all data for one radionuclide therapy or diagnostic dosimetry 

evaluation together, e.g. it contains all data for one dose cycle of radionuclide for one patient. 
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Figure 5: Window New Case. 

 

1. In the window Patient Browser click on the button File in the file menu bar. 

2. Select New Case to open the window New Case (see Figure 5). 

3. Enter all required information. The case name is saved case-insensitive. Therefore, two cases 

with the same names are not allowed.  

The date format is year:month:day (yyyy:mm:dd), e.g. 2018:11:14 and the time format 

hour:minute:second (hh:mm:ss), e.g. 13:59:00. 

Note: The required information depends on the chosen Mode: Default | MAA/SIRT.  

4. Click on the button Create to save the case. 
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5.4 Edit Case 

 CAUTION 

Incorrectly quantified SPECT and PET image data result in incorrect dose values. 

SPECT and PET images are assumed to be quantified in units of Bq/ml. Quantitatively 

reconstructed SPECT and PET images can be directly imported. In case SPECT or PET images 

are not reconstructed quantitatively, a scaling factor must be provided by the user and entered for 

each data set. Scaling factors for quantitative data may be stored in DICOM tags (including private 

tags) of the DICOM image header depending on the manufacturer, e.g. Real World Value Mapping 

Sequence, Rescale Slope. It is the user’s responsibility to check for the scaling factor. Please ask 

the manufacturer of your imaging system for further information. 

 

 CAUTION 

Changing nuclide will reset added organs with precalculated Ã. 

Additional organs with precalculated Ã can be added in Dose Analysis window. The cumulated 

activity of those organs will be reset after changing the nuclide in Edit Case. Always check the input 

to IDAC-Dose calculation by clicking the button Input data. 

 

NOTICE 

Different scans lengths between planar time points may influence time activity curve. 

All planar images are normalized to the total scan duration given in the DICOM header to correct 

for different scan speeds for different time points. It is assumed that the images have the same scan 

length. 

 

NOTICE 

PET data that are decay corrected to time of administration cannot be analysed. 

QDOSE evaluates the DICOM tag ‘Decay Correction’, Only image data with values ‘NONE’ and 

‘START’ can be evaluated with QDOSE. For PET, the acquisition time of the temporally first 

(earliest) slice is regarded as acquisition time for the entire PET image. Acquisition times can be 

manually adapted in the corresponding image tables in Edit Case.  

Images that are decay corrected to the time point of administration of the radiopharmaceutical (value 

‘ADMIN’), cannot be imported into QDOSE.  
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NOTICE 

Changes to the data sets and the times are applied instantly. 

In Edit Case different information about the case and the imported data sets can be edited. Changes 

to the data sets entered in the data set tables (e.g. acquisition times, scaling factors), changes to 

the time of injection and the selected nuclide will instantly change the case information even without 

clicking the Apply button. Also, the deletion of data sets cannot be undone. 

 

 

The window Edit Case offers the possibility to view and handle case related image data and case 

information. 

 

Figure 6: Window Edit Case. 

 

1. In the window Patient Browser click on the button File in the file menu bar. Select Edit Case 

to open the window Edit Case (see Figure 6). 

2. Edit the required information of the case. The information is structured in the following panels 

and tables: 

• Case info: For editing all case related input values 
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• Image info: 

• Planar Images: Table containing loaded planar image data for all time points. 

• NM Images: Table containing loaded nuclear medicine (NM) image data for all 

time points. 

• CT/MR Images: Table containing loaded CT/MRI image data for all time 

points. 

3. In the Planar Images table define the type of the image (EM: emission scan, BL: blank scan, 

TR: transmission scan) in the column Type. Select the energy window for analysis in the column 

Energy Window. For transmission and blank scan, you can select the nuclide (Co57 or 

Tc99m). 

Note: An asterisk * behind the image type indicates which image is already coregistered. 

Note: (R) indicates which image is chosen as reference image for coregistration. 

4. Define the image units and scale factors for the nuclear medicine data sets in the table NM 

Images in the columns Image Unit and Scale Factor. More details can be found in section 

5.4.1. 

Note: The DICOM field Real World Value Mapping Sequence will not be taken into account. 

Please enter the value of the Real World Value Slope as Scale Factor.  

5. For single NM images, select the associated morphological images (CT or MR) in the table NM 

Images in the column AssociatedCT. 

Note: If NM and CT images were acquired simultaneously, the CT images are automatically 

coupled to the corresponding NM image, see column Coupled in table CT/MR Images. In case, 

single NM images are acquired and no corresponding CT/MR series is available, they can be 

associated manually as described above. 

6. For SIRT/MAA mode, select whether the NM image is to be used as pre-treatment data set 

(option PRE) or as post-treatment data set (option POST) by selecting the corresponding option 

in the table NM Images in the column AnalysisGroup. 

Note: An asterisk * behind the coupled NM image indicates which image is chosen as reference for 

coregistration. The following additional actions can be performed: 

- Deletion of selected data sets (separately for planar images, NM images, CT/MR images). 

- Modification of the time information of the selected data set. 

- Display of DICOM header information of the selected data set. 

- Reset of the selected data set to the original DICOM information. 
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5.4.1 System Calibration Factor 

There are two ways to determine a system calibration factor for image units “Counts” for a particular 

radionuclide: by scanning a point source/vial or a uniformity phantom. Depending on the quality of the 

scatter correction of the reconstruction algorithm, the user has to decide which method is more 

appropriate. If scatter correction is not adequate (likely case) a calibration based on a uniformity 

phantom close in size and hence scatter properties to a patient is recommended. 

 

5.4.1.1 Point Source 

 

1. Prepare a point source with a known total activity (activity should be below dead time effects) 

2. Perform a SPECT/CT scan of the source with scanning parameters similar to the patient 
protocol 

3. Reconstruct the data including scatter and attenuation correction using the same 
reconstruction algorithm as for the patient data 

4. Draw a VOI around the point source to measure all counts belonging to the source 

5. Divide the measured counts by the total number of projection for 360° multiplied with the time 
per projection 

6. Divide the known total activity in the point source by the calculated counts per scan time 
which will give you the calibration factor to be entered into QDOSE. 

 

SF [
Bq

cps
] =  

Activity in Vial [Bq]

Total Counts
(Number of Projections  for 360° ∙  Time per Projection [s])

 

 

5.4.1.2 Uniformity Phantom  

 

1. Prepare a uniformity phantom with a known activity concentration e.g. using a cylinder 
phantom 

2. Perform a SPECT/CT scan of the phantom with scanning parameters similar to the patient 
protocol 

3. Reconstruct the data including scatter and attenuation correction using the same 
reconstruction algorithm as for the patient data 

4. Draw a VOI inside a homogenous region of the phantom to measure the total counts inside 
the VOI 

5. Divide the measured counts by the total number of projections for 360° multiplied with the 
time per projection multiplied with the volume of the drawn VOI in ml 

6. Divide the known activity concentration in the phantom by the calculated counts per scan time 
which will give you the calibration factor to be entered into QDOSE. 

 

SF [

Bq
ml⁄

cps
ml⁄

] =  
Activity Concentration in Phantom [

Bq
ml⁄ ]

Total Counts in VOI
(Number of Projections for 360° ∙  Time per Projection [s]) ∙ VOI Volume [ml]
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6 2D Coregistration  

2D Coregistration allows fused view as well as automatic and manual coregistration of whole-body 

planar image between different time points. 

 

 CAUTION 

Incorrect coregistration can lead to incorrect segmentation. 

The coregistration results depend on the quality of the image data. The user must check the 

coregistration result for each time point. The user can adjust the display of the data sets as well as 

the overlay of the reference and 2:nd data set in order to compare the alignment between the data 

sets. 

 

The window 2D Coregistration provides functionality to view and coregister the planar images from 

different time points including the transmission image. The tool also enables the user to choose the 

active view for the blank- and transmission images that are consequently used for attenuation correction 

throughout the planar calculations (see Figure 7). 
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Figure 7: Window 2D Coregistration. 

 

1. The panel Fusion contains two dropdown menus to select the images to be coregistered. 

Select an appropriate reference image from the menu Reference and the intended image from 

menu 2:nd for fused view with an alpha blending defined by the slider Alpha.  

2. Select the color maps and windowing for both images in the panels Reference and 2:nd. 

• The color map can be chosen from the dropdown menu. 

• The windowing can be adjusted using the sliders for UT (Upper Threshold) and LT 

(Lower Threshold). 

3. Perform coregistration between the reference and the chosen image in the panel 

Coregistration using the following options:  

• Automatic: Perform automatic rigid coregistration by clicking on the button Rigid. 

• Manual: Alternatively, or additionally, manual coregistration (translation and rotation) 

between the displayed image data can be performed by clicking on the sliders: 
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• X: for translation in X-direction 

• Y: for translation in Y-direction 

• R: for rotation around the image center. 

Note: After the first coregistration the reference image is fixed. 

Note: Coregistered images are indicated by an asterisk * in the dropdown menu in panel 

Fusion.  

4. Select the next image to be registered from the dropdown menu 2:nd and perform 

coregistration (automatic and/or manual). 

Note: The coregistered image is resized to the reference image. Moving the chosen image 

outside the boundary of the active view can lead to a truncation of image sections. To revert to 

the original view, the coregistration can be reset.  

Note: The coregistration can be reset for single time points by clicking on the button Reset TP 

or for all time points by clicking on Reset All to undo all changes and revert to the originally 

uploaded coordinates. 

5. Select the active view for the blank and transmission images in the panel Blank and 

Transmission. 

6. After all time points are coregistered, press the button Confirm to save the analysis steps and 

to close the window. 
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7 ROI Drawing  

ROI Drawing allows for defining organ boundaries and background region for each organ on planar 

data for later segmentation. 

 

As described in the QDOSE concept, organ segmentation is performed in two different steps. In the 

first step, organ boundaries are defined (drawn) and in a second step, organ segmentation based on 

the boundaries is performed. Organ drawing can be performed on anterior or posterior view, zoomed 

view, also on any time point, and organ boundaries can be copied and pasted to other time points (see 

Figure 8). 

 

Figure 8: Window ROI Drawing. 
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7.1 Define an Organ 

 CAUTION 

Incorrect organ segmentation results in incorrect dose values. 

The user should check the correct position of the boundary for organ delineation. The user can 

adjust the display of the image in order to improve visibility of the image data relative to the drawn 

boundary. 

 

 CAUTION 

Vial calibration should be used with blank and transmission scans. 

If Vial is set as activity reference, it is highly recommended to use transmission and blank scans for 

correct attenuation correction. For this purpose, the organ Vial in the emission scans can be 

separately coregistered to the transmission scan in the window Vial Coregistration (see section 

7.6). 

 

NOTICE 

Whole body calibration needs a segmentation of organ Total Body.  

If the Whole Body is set as activity reference, an organ Total Body will be mandatory to proceed 

with the evaluations. 

 

NOTICE 

Vial calibration needs a segmentation of a Vial. 

If a Vial is set as activity reference, an organ Vial will be mandatory to proceed with evaluation. 

 

An organ is the central element for the dosimetry. In QDOSE the source organs of the radioactivity need 

to be defined to calculate the dose for all other body organs. Organs need to be created and then 

boundaries and segmentations for ROIs in 2D and VOIs in 3D can be assigned to them. 

 

1. Select the intended image in panel Image from the dropdown menu Time Point. 

2. Select the color maps and windowing in the panel Image: 

• The color map can be chosen from the dropdown menu CM. 
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• The windowing can be adjusted using the sliders for UT (Upper Threshold) and LT 

(Lower Threshold) or the field right next to it. 

3. Create an organ by clicking the button Create in the panel Organs. Select from the predefined 

organ list in the dropdown menu or select the option New… and enter a name (e.g. for tumour). 

Confirm by clicking on Create (see Figure 9). 

 

Figure 9: Window Create Organ. 

 

4. Select a drawing mode from the dropdown menu in the panel Boundaries. Drawing options 

are: 

• Free: Draw a boundary by keeping the left mouse button pressed and painting with the 

mouse like with a pencil. 

• Polygon: Draw a boundary by clicking position-by-position around the region in the 

image. The positions are combined automatically to a polygon. 

• Ellipse: Draw a boundary by spanning the ellipse with the left mouse button pressed 

to the desired size. 

5. Click on the button Draw ROI in the panel Boundaries. 

6. Activate the anterior or posterior view by clicking into the image. A white box highlights the 

activated view. 

7. Zoom and pan over an organ if needed using the toolbar elements (see section 16). 

8. Draw the boundary to delineate the organ roughly as described for the drawing options. Further 

editing can be done following the steps in section 7.3. 

9. Click on the button Save ROI in the panel Boundaries to save the drawn boundary.  

10. Information on the organ is automatically updated in the table Organs. 
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7.2 Define Background ROI 

 CAUTION 

Background correction is only applied when background ROI and Patient/Organ thickness 

is defined. 

Background correction for 2D planar images can only be performed, if a background ROI is 

connected to an organ and the patient and the organ thickness is defined for that organ. Otherwise, 

no background correction is performed. Background ROIs can be created and connected to an 

organ in the window ROI Drawing. Patient and organ thickness can be measured in the window 

VOI Segmentation or can be entered in window Organ Properties via the window Dose Analysis. 

 

Detailed information about the correction mechanisms including background correction and the 

necessary steps can be found in section 11.2. 

 

1. Select the intended image in panel Image from the dropdown menu Time Point. 

2. Select the color maps and windowing in the panel Image: 

• The color map can be chosen from the dropdown menu CM. 

• The windowing can be adjusted using the sliders for UT (Upper Threshold) and LT 

(Lower Threshold) or the field right next to it. 

3. Create an organ by clicking the button Create in the panel Organs. Select from the predefined 

organ list in the dropdown menu or select the option New… and enter a name for the 

background ROI (e.g. Background).  

4. Tick the checkbox Background (see Figure 10). 

5. Confirm by clicking on Create. The background ROI is displayed in the organ table with an 

appended (bkg).  

6. Draw a ROI the same way as described in section 7.1, steps 4 - 10. 

7. Link the background ROI to an organ by right-clicking on the intended organ in the table Organs 

and selecting the background ROI as shown in Figure 11. 

 

Note: It is possible to use one background ROI for different organs. 
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Figure 10: Option Background in window 
Create Organ. 

 

 

 

 

Figure 11: Option to link Background ROI 
to Organ in table Organs. 

 

7.3 Edit Organ 

1. Select the organ to be edited from the table Organs, if not already selected. 

2. Click on the drawn boundary in the image. The boundary will turn to white color. 

3. You have two options to edit the ROI: 

• Moving: to move the entire region, press Shift and move the whole object to the new 

location via drag and drop. 

Note: Do not click to closely to the white boundary when moving via drag and drop. 

• Painting: to paint the boundary brush-like, keep the left mouse button pressed until a 

white circle is displayed (see Figure 12). Edit the boundary from the region outside or 

inside, by moving the circle like a brush. The left mouse button needs stay pressed. 

The radius of the circle can be changed using the slider Radius in the panel 

Boundaries. 

 

 

Figure 12: Brush Tool. 
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4. Click on the button Save ROI in the panel Boundaries to save the edited boundary or click on 

the button Cancel in the panel Boundaries to discard any changes to the boundary.  

5. Information for the organ is automatically updated in the table Organs. 

 

7.4 Copy/Paste Organ 

 CAUTION 

Incorrect organ segmentation results in incorrect dose values. 

After copy and paste of ROIs, the ROIs may not contain the organ or region at all time points due 

to local misalignment between the time points. The user must check the position of the ROI for each 

organ at each time point. This can be done by selecting the organs in the table Organs and scrolling 

through all time points while checking the position in the window ROI Segmentation. If the positions 

of the ROIs are not sufficient, the user can edit the organ boundary for each time point in the window 

ROI Drawing. 

 

The source organs must be defined in the images for all time points in order to include them in the time-

activity-curve calculation. The ROIs for the organs can be copied and pasted from one time point to 

another. 

 

1. Select the intended image in panel Image from the dropdown menu Time Point. 

2. Select the organ to be copied from the table Organs, if not already selected. 

3. Right-click on the image will open an options list. Select Copy ROI. 

4. Select the next intended time point in panel Image from the dropdown menu Time Point. 

5. Right-click on the image will open an options list (see Figure 13). Here you have the following 

options: 

• Paste ROI: Pastes the copied ROI to this time point only. 

• Paste ROI to All: Pastes the copied ROI to all time points in this case, including the 

transmission scan. 

6. Alternatively, the option Propagate (see Figure 13) can be used to copy and paste all organs 

from the chosen time point to all time points. 
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Figure 13: Options list for copy and paste of regions. 

 

Shortcuts  

• Right-click: on the image to open the context menu for copy/paste 

 

7.5 2D Coregistration 

 CAUTION 

Changes in 2D Coregistration might influence Vial Coregistration. 

Additionally, to the 2D Coregistration, a vial coregistration can be performed (see section 7.6). 

Changing the 2D Coregistration might affect the vial coregistration. If a vial coregistration was 

already performed, the user should check if the vial coregistration is still valid and if necessary, 

perform a new vial coregistration. 

 

QDOSE provides rigid 2D coregistration between different time points. As the copy/paste process 

between different time points accelerates the boundary definition process, we strongly recommend 

users to undergo the coregistration process. QDOSE will prompt the user if images have not been 

coregistered. More details on 2D coregistration can be found in section 6 of this manual. 

The user can go back to the window 2D Coregistration by clicking on the corresponding button in the 

lower left corner. 

7.6 Vial Coregistration 

Since a Vial can be used for sensitivity calibration, the accuracy of the estimated vial counts is very 

important. Therefore, QDOSE provides a dedicated tool that coregisters the ROI of the vial at each time 

point with the transmission image for improved attenuation correction. Click on the button Vial 

Coregistration to perform this step. The button Vial Coregistration is only highlighted if an organ Vial 

has been drawn on all time points. 
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Figure 14: Window Vial Coregistration. 

 

1. The view is already fused, while the reference image is the transmission scan. The alpha 

blending can be adjusted in the panel Coregistration with the slider Alpha. 

2. Select the color maps and windowing for both images in the panels Transmission image (Ref) 

and Emission image. 

• The color map can be chosen from the dropdown menu CM. 

• The windowing can be adjusted using the sliders for UT (Upper Threshold) and LT 

(Lower Threshold). 

3. Perform coregistration between the reference and the chosen image in the panel 

Coregistration using the following options: 

• Manual: Manual coregistration (translation and rotation) between the displayed image data 

can be performed by clicking on the sliders: 

• X: for translation in X-direction 

• Y: for translation in Y-direction 
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• Rotate: for rotation around the image center. 

• Automatic: Perform automatic rigid coregistration by selecting an algorithm from the 

dropdown menu and clicking on the button Run. Available algorithms are: 

• Mutual information: coregistration based on the entropic correlation between the 

information of the two images 

• Center of Gravity: coregistration based on the geometrical centroid of the image 

intensity 

Note: By clicking on Run, the coregistration is automatically applied to all time points, as 

indicated by an asterisk * in the dropdown menu. The results can be checked by selecting each 

time point. 

Note: The coregistration can be reset for all time points by clicking on the button Reset. 

4. After all time points are coregistered, press the button Confirm to save the analysis steps and 

to close the window. 
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8 ROI Segmentation  

ROI Segmentation allows organ based coregistration and segmentation within the boundaries 

defined on the planar data for determination of time-activity-curves for each organ. 

 

The organ coregistration enables the correction of relative organ movements within the time points, 

where the coregistration is based on the segmented region. The threshold-based segmentation, within 

the boundary definition, makes organ definition faster, more reproducible and less operator dependent. 

Each organ with boundaries defined at all time points is set as completed and is ready to be further 

coregistered and segmented. The quality of the coregistration is further illustrated by the alignment 

curves in the lower section below the images. The alignment curves illustrate the agreement of the 

reference image (gray line) and each time point using sum profiles in X- and Y-direction (blue line). 

 

Figure 15: Window ROI Segmentation. 

 

1. Adjust the display of the images by image normalization in the panel Image. Options are:  

• Max: For image normalization, the maximum value is taken from each time point separately 

(option Each TP) or from all time points (option All TPs). 

• Area: For image normalization, the maximum value is taken from the selected view for 

segmentation (see step 5) only within the defined ROI (option ROI) or the entire image 

(option Image).  
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Note: The table Organs indicates in the checkboxes whether an organ has already been 

viewed (column Viewed) and if all boundaries have been drawn in previous stage (column 

Complete). 

2. Select the organ to be segmented in the table Organs.  

3. The ROI of the selected organ is displayed in the image view for all time points, with the 

following boundaries: 

• Red: indicates the drawn boundary from the previous step of ROI drawing. 

• Orange: indicates the segmentation result. 

• Solid | dashed: the solid line indicates which time point is currently chosen as 

reference time point. The images of the other time points need to be registered and 

therefore outlined with a dashed line. 

Note: In the beginning, a segmented ROI is shown based on a default threshold segmentation 

(50% of maximum value within the boundary). If the organ has already been segmented, the 

threshold will be the same as previously set. 

4. Select the reference time point for segmentation from the dropdown menu Ref. in the panel 

Segmentation, typically the one which best displays the organ activity.  

The selected reference time point is also reflected in the alignment curves as gray line. 

5. Select the view for segmentation from the dropdown menu: Posterior or Anterior.  

6. Define threshold for segmentation using the slider in panel Segmentation. For planar images, 

only a grayscale-based, manual threshold segmentation is available. The threshold is 

expressed as percentage value of the drawn boundary. The segmentation result from the 

reference time point (solid orange line) is put on all other time points (dashed orange lines). 

7. After the segmentation on the reference image is sufficient, perform a coregistration of the ROIs 

to account for organ movements which may not have been covered by 2D coregistration. The 

alignment curves are updated automatically. Options in panel Coregistration are: 

• Automatic: Perform automatic organ coregistration for all time points by clicking on 

Run. 

• Manual: Perform manual organ coregistration for the chosen time point in the 

dropdown menu Time Point, by using the sliders: 

• X: for translation in X-direction 

• Y: for translation in Y-direction 

• R: for rotation around the image center. 
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Note: For manual segmentation, each time point has to be coregistered separately, while 

the automatic coregistration is applied to all time points. 

Note: Counts per second (counts normalized to total scan duration) values for all time points 

are updated in the table in the lower left corner. 

 

Depending on the mode and uploaded images, various options are available as next steps which can 

be performed by clicking on the buttons:  

• VOI Segmentation: if volumetric data are available (see section 10). This is required if 

volumetric or hybrid dose calculations are to be performed. 

• Dose Analysis: if no volumetric image is available or hybrid or volumetric calculations are not 

required (see section 11).  
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9 3D Coregistration  

3D Coregistation allows volumetric coregistration of all time points using CTs as reference, or for 

each time point between CT and NM images. 

 

 CAUTION 

Incorrect coregistration can lead to incorrect segmentation. 

The coregistration results depend on the quality of the image data. The user must check the 

coregistration result for each time point. The user can adjust the display of the data sets as well as 

the overlay of the reference and 2nd data set in order to compare the alignment between the data 

sets. 

 

NOTICE 

Volumetric coregistration is time consuming. 

Volumetric coregistration with large CTs can be time and memory consuming. Furthermore, to 

accelerate the manual coregistration process, it is recommended to first perform the translations (in 

X- and Y-direction) before rotation is applied. 

 

 CAUTION 

Insufficient image overlap can lead to incorrect deformable coregistration. 

The coregistration results depend on the quality of the image data. The user must check if the image 

content of the image to be coregistered is overlapping with the reference image before performing 

a deformable (elastic) coregistration. The user can adjust the display of the data sets as well as the 

overlay of the reference and 2nd data set in order to compare the alignment between the data sets. 

If the overlap is insufficient, the user must perform a manual or automatic rigid coregistration before 

applying the deformable coregistration. 

 

3D coregistration can be done: 

• to either coregister image pairs (CT and NM images) between different time points, or 

• to coregister a CT with its corresponding NM image for each time point 
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Figure 16: Window 3D Coregistration. 

 

1. The panel Fusion contains two dropdown menus to select the images to be coregistered. 

Select an appropriate reference image from the menu Reference and the intended image from 

menu 2nd for fused view. 

2. The alpha blending can be adjusted using the slider Alpha. The checkbox Show NM enables 

choosing, if you want to coregister only CT images or if you want to coregister between CT and 

NM image. A marked checkbox Show NM indicates the coregistration between CT and NM 

image. In this case the panel Reference and 2nd Volume (see Figure 17) are changed into 

CT and NM (see Figure 18). 

 

Figure 17: Panels for coregistration of only 
CT images. 

 

Figure 18: Panels for coregistration of CT 
and NM images. 
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3. Select the windowing for CT images in the panels Reference, 2:nd Volume or CT (see Figure 

17): 

• Window: In the upper dropdown menu, a window can be chosen from a list of 

predefined windows. The syntax is defined as window width/window center in 

Hounsfield Units (HU) (e. g. 300/40 means a window with a width of 300 HU around a 

center of 40 HU. 

• Win: slider for fine adjustment of window width 

• Ctr: slider for fine adjustment of window center 

4. Select the windowing for NM images in the panels NM (see Figure 18): 

• Window: In the upper dropdown menu, a window can be chosen from a list of 

predefined windows. The syntax is defined as lower threshold/upper threshold in 

counts (e. g. 10%: 0/219 means a window from 0 to 219 counts, representing up to 

10% of the maximum counts). 

• The windowing can be adjusted using the sliders for UT (Upper Threshold) and LT 

(Lower Threshold). 

5. Select the colour maps for both images in the panels Reference and 2:nd Volume or CT and 

NM respectively. The colour map can be chosen from the lower dropdown menu. 

6. Set the reference for image alignment in panel Image Reference. Options are: 

• Origin: uses the DICOM information for origin of coordinate system 

• Image Center: recalculates the coordinates based on the image center. For NM images 

(Show NM activated), the image center corresponds to the image center of the coupled 

or associated CT image. 

7. Perform coregistration between the reference and the chosen image in the panel 

Coregistration using the following options: 

• Automatic: Perform automatic coregistration by clicking the button Rigid for rigid or 

the button Deformable for elastic coregistration. 

• Manual: Alternatively or additionally, manual coregistration (translation and rotation) 

between the displayed image data can be performed by clicking on the sliders: 

• X: for translation in X-direction 

• Y: for translation in Y-direction 

• Z: for translation in Y-direction 

• XR: for rotation around the X-axis 

• YR: for rotation around the Y-axis 

• ZR: for rotation around the Z-axis 
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Note: The button Deformable for elastic automatic coregistration is only enabled for 

coregistration of CT images. 

Note: For optimal results, perform manual or automatic rigid coregistration to align the images 

before performing deformable automatic coregistration. This should be done both for the 

coregistration between CTs as well as the coregistration between CTs and NMs (Show NM 

activated). 

Note: Coregistered images are indicated by an asterisk * in the dropdown menu in panel 

Fusion. In 3D Coregistration, the reference image is not marked with an asterisk *, even if it 

is coregistered. 

Note: The coregistration between CT images is also applied to the coupled NM images. 

However, they are not marked with an asterisk * automatically. The asterisk * is only set, if the 

NM was coregistered to a CT explicitly. 

8. Select the next image to be registered from the dropdown menu 2:nd Volume and perform 

coregistration (automatic and/or manual). 

Note: The coregistration can be reset for single time points by clicking on the button 

Reset Selected or for all time points by clicking on Reset All to undo all changes and revert to 

the originally uploaded coordinates.  

9. After all time points are coregistered, press the button Confirm to save the analysis steps and 

to close the window. 
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10 VOI Segmentation  

VOI Segmentation allows for viewing, drawing boundaries and segmenting within the boundaries to 

determine time-activity-curves for each organ. 

 

The image display can display the single modality (NM or CT/MR) as well as fused images. The VOIs 

consist of 3 parts: 

• Boundary (outlined in orange): delineated region to separate it from its surroundings. This area 

is then used for further segmentation. 

• Segmented volume (outlined in red): Volume VOI used for calculation of organ volume. 

• Segmented activity (outlined in yellow): Activity VOI used for calculation of organ activity to be 

used in the dose calculation step.  

The tool VOI Segmentation also provides a set of tools for segmentation of an organ within a boundary 

in either NM, CT, or fused mode. Organ and patient limits (thickness) for background correction of 

planar data (when using Hybrid mode) can also be defined here. 

The functionalities provided are: 

• Image display including color and LUT manipulation. 

• Organ creation including suborgans. 

• Drawing and editing of organ boundaries.  

• Segmentation of volume and activity VOIs. 

• Definition of patient and organ limits (thickness). 
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Figure 19: Window VOI Segmentation. The boundary of the organ displayed as orange line, the 
Activity VOI as yellow line and the Volume VOI as red line. 

 

Shortcuts  

• Arrow Keys Up/Down: to move one slice in the active view 

• Arrow Keys Left/Right: to move 10 slices in the active view 

• Shift + Left-click: when in edit mode enables moving the volume 

• Left-click: click in the active view changes all views to the selected point (Shift + Left-click 

when in boundary drawing mode) 

• Right-click: in the images opens the context menu for copy-/pasting organs between time 

points 

 

10.1 Image View 

1. Select the intended image time point in the panel Image from the dropdown menu Time Point. 

The time points are ordered based on the date and time of the image. 

2. Select the main image slicing plane from the dropdown menu: Axial, Coronal or Sagittal. The 

main plane is displayed large in the window center while the other two planes are displayed 

smaller on the right side. 

3. Select the image modality from the dropdown menu in the right upper corner of the panel 

Image: PET/SPECT, CT/MR or Fused.  
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4. Select the windowing for image view. Depending on the image modality, different windowing 

options are available: 

 

Figure 20: Windowing 
options for modality 
PET/SPECT. 

 

Figure 21: Windowing 
options for modality 
CT/MRT. 

 

Figure 22: Windowing 
options for modality Fused. 

 

Select the windowing for PET/SPECT images in the panel Image (see Figure 20): 

• Window: In the upper dropdown menu, a window can be chosen from a list of 

predefined windows. The syntax is defined as lower threshold/upper threshold in 

counts (e. g. 10%: 0/219 means a window from 0 to 219 counts, representing up to 

10% of the maximum counts). 

• The windowing can be adjusted using the sliders for UT (Upper Threshold) and LT 

(Lower Threshold). 

Select the windowing for CT/MR images in the panel Image (see Figure 21): 

• Window: In the upper dropdown menu, a window can be chosen from a list of 

predefined windows. The syntax is defined as window width/window center in 

Hounsfield Units (HU) (e. g. 300/40 means a window with a width of 300 HU around a 

center of 40 HU. 

• Wi: slider for fine adjustment of window width 

• CT: slider for fine adjustment of window center 

For mode Fused, the windowing options are disabled as the settings from the single modalities 

are used. The alpha blending between the two images can be adjusted using the slider under 

the dropdown menu for the image modality. 

Note: The Window/Center and UT/LT are preset from the DICOM header. For CT images, a 

window optimized for soft- and lung tissue is provided. 

Note: When changing the image time point, relative scaling of the previous image is used to 

display the selected time point.  

5. Select the color map for the selected modality from the lower dropdown menu in panel Image.  
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10.2 Organ Handling 

1. Create an organ by clicking the button Create in the panel Organs. Select from the predefined 

organ list in the dropdown menu or select the option New… and enter a name (e.g. for tumour). 

Confirm by clicking on Create (see Figure 9). 

2. To create a suborgan to a currently available organ, select the parent organ from the table 

Organs and tick the checkbox Suborgan Then click the button Create. Select from the 

predefined organ list. If the organ is not available (e.g. Tumour), select New... from the list and 

enter a name. 

3. Delete an organ by selecting the organ from the table Organs and clicking on the button Delete. 

 

10.3 Define Organ 

 CAUTION 

Incorrect organ segmentation results in incorrect dose values. 

The user should check the correct position of the boundary for organ delineation. The user can 

adjust the display of the image in order to improve the visibility of the image data relative to the 

drawn boundary. 

 

NOTICE 

Segmentation on image data with different resolutions influences the segmentation results. 

The resolution of the drawn boundary is depending on the underlying image resolution (voxel size). 

Hence, if a boundary is drawn on the NM image, it will have a much lower resolution than on the 

CT image. The VOI is accessible in the other corresponding images for calculation independent of 

its origin (the image where it has been drawn). 

 

• Set the time point, modality (NM, CT, Fused), main view (axial, coronal, sagittal), colour maps 

and windowing as described in section 10.1. 

• Select an existing organ or create an organ following step 1 in section 10.2. 

• Start drawing a boundary to roughly delineate the organ and save as described in the following 

section 10.3.1. Boundary drawing can be performed in the active view. 

• Segment Volume and Activity VOI within the boundary to define anatomical region and region 

from which the activities are collected, as described in the following section 10.3.2. It is possible 

to define activity and volume regions independently on CT/MR and/or NM. 
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Note: Organ statistics are displayed in the table Organs providing specific information about 

each organ. 

 

10.3.1 3D Boundary Drawing 

A 3D boundary or VOI consist of a stack of 2D ROIs, which can either be propagated from one slice to 

the neighbouring slices or be redrawn separately on each slice. All tools are collected in the panel Draw 

Boundaries in the panel Boundaries and Segmentation. 

Shortcuts 

• Shift + Left-click: For setting the cross position in drawing mode. 

 

10.3.1.1 Draw Regions 

1. Click on the button Draw ROI in the panel Draw Boundaries. 

2. Select a display to become active by clicking into the image. A white box highlights the activated 

view. 

3. Select a drawing mode from the dropdown menu in the panel Draw Boundaries. Start drawing 

by using the following drawing options: 

• Free: Draw a boundary by keeping the left mouse button pressed and painting with the 

mouse like with a pencil. 

• Polygon: Draw a boundary by clicking position-by-position around the region in the 

image. The positions are combined automatically to a polygon. 

• Ellipse: Draw a boundary by spanning the ellipse with the left mouse button pressed 

to the desired size. 

4. Click on the button Save ROI in the panel Draw Boundaries to save the drawn boundary. 

5. Edit the ROI, if necessary, by moving or painting it. First click again the button Draw VOI to go 

to editing mode, then: 

• Moving: to move the entire region, press Shift and move the whole object via drag and 

drop to the new location. 

Note: Do not click to closely to the white boundary when moving via drag and drop. 

• Painting: to paint the boundary brush-like, keep the left mouse button pressed until a 

white circle is displayed (see Figure 12). Edit the boundary from the region outside or 

inside, by moving the circle like a brush. The left mouse button needs to stay pressed. 

The radius of the circle can be changed using the slider Radius in the panel 

Boundaries. 
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6. Click on the button Save ROI in the panel Draw Boundaries to save the drawn boundary. 

7. Information for the organ is automatically updated in the table Organs. 

 

10.3.1.2 Propagate Region 

Propagating serves to quickly copy and paste drawn ROIs from one slice to another slice. 

1. The visible region on the current slice can be propagated to the next or previous slice(s) by 

using the buttons < and > in the panel Draw Boundaries. The button < will propagate the ROI 

to next slice the active view (e.g. For axial view, the next axial slice in cranial direction, as 

displayed in Figure 23). The button > will propagate the ROI in the opposite direction. 

Note: The number of slices the region will be propagated to can be defined simultaneously in 

the field on the left side of the button < (see Figure 23). 

Regions can be edited / redrawn at any time while in draw mode. 

 

   

Figure 23: Propagation of ROIs over neighbouring slices using the buttons < and >. 

 

10.3.1.3 Interpolate between ROIs 

Interpolation serves to only draw ROIs in some slices and interpolate the missing ROIs in-between. 

1. Draw separate ROIs only in some slices to roughly define an organ as described in section 

10.3.1.1. 

2. When clicking the button Save, a dialog window will pop up asking if the missing ROIs are to 

be interpolated. Confirm the interpolation. The calculation may take a few seconds to minutes. 

 

10.3.1.4 Delete ROIs 

If necessary, ROIs/VOIs can be deleted using the following buttons in the panel Draw Boundaries: 

• Clear ROI: removes the ROI from the selected slice. 

• Clear VOI: removes all ROIs from all the slices, i.e. the entire volume. 

• Clear VOI (all TP): removes the VOIs of the selected organ from all the time points. 
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10.3.2 3D Segmentation 

 CAUTION 

Incorrect organ segmentation results in incorrect dose values. 

The segmentation depends on the quality of the image data sets. The user should check the result 

of the segmentations by viewing all slices and checking if the outline of the segmentation is correct 

and the results can be used for further analysis. 

 

As previously described in the QDOSE concept, QDOSE is using two distinct regions for the calculation 

of organ volume and activity. While the volume calculation is based on the modality the segmentation 

was performed on, activity segmentation is always calculated from the NM data. 

Volume and activity regions can be segmented independently from SPECT and/or CT/MR images. 

Alternatively, they can be calculated from the same image, while the activity is based on the volume 

obtained from CT or MR convolved with a Gaussian function (representing the point spread function 

(PSF) of the NM imaging system) to compensate the spill-out from the inferior resolution of NM images. 

In general, the visualized image is the base for segmentation. All tools are collected in the panel Organ 

Segmentation in the panel Boundaries and Segmentation. 

 

10.3.2.1 Manual Segmentation 

 

Figure 24: Panels for manual segmentation 
of NM images. 

 

Figure 25: Panels for manual segmentation 
of CT/MR images. 

 

When a NM image is displayed: 

1. In the panel Organ Segmentation select the option Manual from the dropdown menu Method. 

2. In the panel Threshold below, the threshold for activity segmentation to obtain the VOI 

corresponding to activity can be defined. For NM images, only the activity VOI can be 

segmented. Set the values for the lower and upper threshold using the fields and arrow buttons 
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indicated by Activity (%) (see Figure 24). The threshold values are expressed as percentage 

of the maximum value within the drawn boundary. 

3. Click on the button Run. The segmentation result is displayed as a yellow boundary in the 

image. 

4. Adjust the thresholds if necessary. 

5. Tick the checkbox Enable Volume Segmentation to segment the anatomical volume based 

on a separately defined threshold.  

6. Set the lower and upper threshold for the anatomical VOI in the field indicated by Volume (%) 

(see Figure 25). 

7. Click on the button Run. The segmentation result is displayed as a red boundary in the image. 

When a CT or MR image is displayed: 

1. In the panel Organ Segmentation, select the option Manual from the dropdown menu Method. 

2. In the panel Threshold below, the threshold for volume segmentation to obtain the VOI 

corresponding to anatomical volume can be defined. For CT/MR images, only the volume VOI 

can be segmented. Set the values for the lower and upper threshold using the fields and arrow 

buttons indicated by Volume (%) (see Figure 25). The threshold values are expressed as 

percentage of the maximum value within the drawn boundary. 

3. Click on the button Run. The segmentation result is displayed as a red boundary in the image. 

4. Adjust the thresholds if necessary. 

5. Tick the checkbox Activity = Volume+FWHM [mm] to segment the activity volume obtained 

from CT or MR convolved with a PSF with the specified full width half maximum (FWHM).  

6. Set the value for the full width half maximum (FWHM) in the field right next to it (see Figure 25). 

7. Click on the button Run. The segmentation result is displayed as a red boundary in the image. 
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10.3.2.2 Auto SBR Segmentation 

 CAUTION 

Incorrect organ segmentation results in incorrect dose values. 

The calibration data for the Auto SBR Segmentation algorithm was generated using a specific 

SPECT scanner. Hence, the segmented VOIs based on automatic thresholds from this calibration 

may not be equally appropriate for other SPECT scanners. Check the segmentation result by 

scrolling through all slices for the segmentation. 

 

NOTICE 

Auto SBR is only available for NM images. 

This option is only available when NM images are displayed and for selected nuclides where 

calibration data is available. The display of CT/MR images can be activated by selection of the 

option CT/MR from the dropdown in the panel Image. 

 

NOTICE 

Segmentation results with Auto SBR are depending on the volume size. 

The results of volume and activity segmentation with Auto SBR are depending on the signal-to-

background ratio within the VOI. For small volumes, this is not sufficient due to partial volume effect. 

The optimal threshold is depending on the signal-to-background ratio and the volume size. This 

may have an impact on the segmentation results with Auto SBR in a way that the activity is 

overestimated for small volumes (e.g. tumour lesions) and underestimated for large volumes. Check 

the segmentation result by scrolling through all slices for the segmentation.  

 

The algorithm Auto SBR automatically determines the volume and activity threshold based on a 

calibration curve. Activity segmentation as well as Volume segmentation is performed on the NM image. 

It is only available for NM images. 

 

1. This option can be applied by selecting Auto SBR from the dropdown menu Method. 

2. Click on the button Run. The segmentation result is displayed in the image (Volume 

segmentation outlined in red and Activity segmentation outlined in yellow). 
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10.3.2.3 Fuzzy C Means Cluster Segmentation 

 CAUTION 

Incorrect organ segmentation results in incorrect dose values. 

The option Fuzzy C Means segmentation automatically segments the organs/structures on CT/MR 

or SPECT/PET images. Depending on the quality of the images, the result of this segmentation may 

vary. Check the segmentation result by scrolling through all slices for the segmentation. 

 

The algorithm of Fuzzy C Means cluster segmentation defines clusters based on the counts histogram 

in the defined boundary. Segmentation will then be performed on data clusters to be included or 

excluded as defined by the user. 

 

1. This option can be applied by selecting Fuzzy C Means from the dropdown menu Method. 

2. If a CT/MR image is displayed, tick the checkbox Enable Activity Segmentation to enable 

activity segmentation or vice versa tick Enable Volume Segmentation on SPECT/PET.  

3. Click on Run. The window Cluster Segmentation Configuration will open (see Figure 26). 

4. Set values for the following parameters: 

• Number of clusters defines the number of clusters in which the greyscale histogram 

is divided. The histogram is display above. Change this parameter using the slider or 

the entry field. Set the total number of clusters to correspond to the expected number 

of data clusters: e.g. background, scatter, spill-over and uptake. 

• Weight exponent: defines the crispiness/fuzziness of clusters. Change this parameter 

using the slider or the entry field. 

• Included regions volume: For CT/MR images, it defines the lower and upper cluster 

of all clusters that are included in the segmentation. Change the values using the 

dropdown menus. 

• Included regions activity: For NM images, it defines the lower and upper cluster of 

all clusters that are included in the segmentation. Change the values using the 

dropdown menus. 

• Only One Region: This checkbox defines that the segmentation result will only be one 

VOI. 

Note: Good first results can be achieved with the following settings: 

Number of clusters = 10 

Weight exponent = 1.1 
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Included regions volume/ activity = 2 - 10 

5. To start the segmentation with the selected parameters click Run in window Cluster 

Segmentation Configuration. The segmentation result is displayed as a red boundary for the 

volume VOI and a yellow boundary for the activity VOI in the image. 

 

Figure 26: Window Cluster Segmentation Configuration. 

 

10.3.2.4 Convolution 

The algorithm Convolution automatically determines the activity VOI based on the volume 

segmentation obtained from CT or MR convolved with a PSF with the specified full width half maximum 

(FWHM). This means a volume VOI needs to be defined beforehand. 

1. This option can be applied by selecting Convolution from the dropdown menu Method. 

2. Tick the checkbox Activity = Volume+FWHM [mm].  

3. Set the value for the full width half maximum (FWHM) in the field right next to it (see Figure 25). 

4. Click on the button Run. The segmentation result is displayed as a yellow boundary for the 

activity VOI in the image. 
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10.3.2.5 AIT-Liverator 

 CAUTION 

False organ segmentation results in false dose values. 

The algorithm AIT-Liverator automatically segments the liver on CT images. Depending on the 

quality of the images the result of this segmentation may vary. Low-resolution CT images (e.g. CT 

images acquired for attenuation correction) are not suitable. Check the segmentation result by 

scrolling through all slices for the segmentation. 

 

NOTICE 

AIT-Liverator is only available for CT images. 

The algorithm AIT-Liverator is only available if CT image data is available and selected. The display 

of CT images can be activated by selection of the option CT/MR from the dropdown menu in the 

panel Image.  

 

The AIT-Liverator automatically segments the liver, the kidneys and the spleen on CT images. 

1. Draw a boundary around the liver, following the steps in section 10.3.1. 

2. Select the option AIT-Liverator from the dropdown menu Method. 

3. If the activity volume needs to be segmented too, tick the checkbox Activity = Volume+FWHM 

[mm] to segment the activity volume.  

4. Set the value for the full width half maximum (FWHM) in the field right next to it (see Figure 25). 

5. Click on the button Run. The segmentation result is displayed as a red boundary for the volume 

VOI and as a yellow boundary for the activity VOI in the image. 

Note: If the segmentation process was terminated with the message “Failed to run liverator – timeout”, 

the parameter for the Liverator Timeout can be increased under File > Settings. 

 

10.4 Define Background VOI 

For volumetric dosimetry, correction of background activity can be performed. Detailed information 

about the correction mechanisms including background correction and the necessary steps can be 

found in section 11.2. The steps are the same as for 2D, as previously described in section 7.2. The 

only difference is that a background VOI is drawn, instead of a background ROI. 

1. Select the intended image in panel Image from the dropdown menu Time Point. 

2. Select the color maps and windowing in the panel Image: 
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• The color map can be chosen from the dropdown menu CM. 

• The windowing can be adjusted using the sliders for UT (Upper Threshold) and LT 

(Lower Threshold) or the field right next to it. 

3. Create an organ by clicking the button Create in the panel Organs. Select from the predefined 

organ list in the dropdown menu or select the option New… and enter a name for the 

background ROI (e.g. Background).  

4. Tick the checkbox Background (see Figure 10). 

5. Confirm by clicking on Create. The background ROI is displayed in the organ table with an 

appended (bkg).  

6. Draw a background VOI near the source organ the same way as described in section 

10.3.1.1. 

7. Link the background VOI to an organ by right-clicking on the intended organ in the table 

Organs and selecting the background VOI as shown in Figure 11. 

 

Note: It is possible to use one background ROI for different organs. 

 

10.5 Edit Organ VOIs 

1. Select the active display by clicking into the image. A white box highlights the activated view. 

2. Select the VOI to be edited (volume, activity, boundary) by left-clicking on the region. 

3. There are two options to edit the VOI: 

• Moving: to move the entire region, press Shift and move the whole object to the new 

location via drag and drop. 

Note: Do not click too closely to the white boundary when moving via drag and drop. 

• Painting: to paint the boundary brush-like, keep the left mouse button pressed until a 

white circle is displayed (see Figure 12). Edit the boundary from the region outside or 

inside, by moving the circle like a brush. The left mouse button needs to stay pressed. 

The radius of the circle can be changed using the slider Radius in the panel Draw 

Boundaries. 

4. Click on the button Save VOI in the panel Draw Boundaries to save the edited boundary or 

click the button Cancel in the panel Draw Boundaries to discard changes to the boundaries.  

5. Information for the organ is automatically updated in the table Organs. 
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10.6 Copy/Paste Organ 

 CAUTION 

Incorrect organ segmentation results in incorrect dose values. 

After copying and pasting of VOIs, the VOIs may not contain the organ or region at all time points 

due to local misalignment between time points. The user must check the position of the VOI for 

each organ at each time point. This can be done by selecting the organs in the table Organs at 

each time point and scrolling through all slices of the data set. If the positions of the VOIs are not 

sufficient, the user can edit the organ boundary for each time point or redraw the whole boundary 

and perform a new segmentation. 

 

1. Select the intended image in panel Image from the dropdown menu Time Point, if not already 

selected. 

2. Select organ from the table Organs, if not already selected, by clicking on it. 

3. Right-click on the image, select Copy and one of the options from the list (see Figure 27): 

• All: copies boundary, activity segmentation and volume segmentation 

• Boundary: copies only the boundary of the organ (orange line) 

4. Select the next intended time point in panel Image from the dropdown menu Time Point. 

5. Right-click on the image will open an options list (see Figure 28). Here you have the following 

options: 

• Paste: pastes the copied VOI(s) to this time point only. 

• Force Paste: this way the copied VOI can be pasted to another organ. 

Note: The target organ must be selected from the table Organs before clicking Force 

Paste. 

6. Alternatively, the option Propagate (see Figure 28) can be used to copy and paste all organs 

from the chosen time point to all time points. Here you have the following options: 

• All regions: pastes all VOI(s), including boundary, activity and volume segmentation, 

of all organs to all time points. 

• New only: pastes VOI(s) to time points that do not have a drawn VOI, including 

boundary, activity and volume segmentation, of all organs to all time points.  

7. If needed, VOIs can be edited separately at each time point, as required (see section 10.5). 
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Figure 27: Options for copying 
regions. 

 

Figure 28: Options for pasting and propagating 
regions. 

 

10.7 Define Organ Thickness 

 CAUTION 

Patient and Organ Thickness influence the dose calculation. 

If the patient and/or organ thickness is edited in the window Organ Properties, the edited values 

will be used for background correction of planar data for the further dose calculations in planar or 

hybrid mode automatically. No further confirmation of applying the background correction is 

necessary. 

 

The organ and patient thickness for each organ can be defined for planar background correction. There 

are two possible ways of defining the thickness values: entering them manually or measuring them on 

3D images. For further information about the correction mechanisms and the necessary input values, 

please refer to section 11.2. 

 

The first method is explained in section 11.5. 

The second method is explained here, as follows: 

1. Set the cross-hair point to the position of the patient/organ limit in the image. 

2. Select the corresponding limit type from the dropdown menu in the panel 

Patient / organ limits. 

3. Click on the button Save right next to it. 

4. Repeat this for all four limit types of the dropdown menu. 

Note: Thicknesses will be displayed in the table Organs after both upper and lower limit is set 

for organ or patient. 
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11 Dose Analysis  

Dose Analysis allows curve fitting, activity integration, dose calculation using IDAC-Dose, spherical 

model or Voxel S and report generation/value export to Olinda. 

 

Dose Analysis allows curve fitting and dose calculation for different dosimetry modes – i.e. planar, 

hybrid, volumetric. For each mode, the curve fitting, and dose calculation can be performed separately 

based on the regions defined in previous steps, to compare the different dosimetry approaches. 

Dose Analysis further provides dose calculation using: 

• IDAC-Dose 1.0 

• IDAC-Dose 2.1 

• Spherical model 

• Voxel S 

• Export of obtained cumulated activities and residence times as a case file readable by 

Olinda/EXM 1.1. 

Shortcuts  

• Right-click on a selected organ: to open context menu for curve fitting, organ properties. 

 

Figure 29: Window Dose Analysis. 
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11.1 Mode 

As explained in the QDOSE concept, QDOSE can calculate doses using either planar, hybrid or 

volumetric methodology. Based on the data used for analysis, different modes will be available. The 

calculations done in each mode are independent from other modes. 

1. Select the mode for the intended dose calculation from the dropdown menu Mode: Planar, 

Hybrid, Volumetric. 

 

11.2 Correction Mechanisms 

The correction mechanisms are specific for the image modality (2D or 3D). The applied corrections are 

independent of each other. E. g. for a case with 2D and 3D data, the corrections for the 2D data are 

independent of the corrections applied to the 3D data. 

 

11.2.1 2D Corrections for Planar and Hybrid Mode 

The activity A for each ROI is calculated using the formula below applying the corrections according to 

MIRD pamphlet 16 (Siegel et al., 1999): 

𝐴 = √
𝐼𝐴 ∙ 𝐼𝑝

𝑒µ𝑡
∙ 𝑓 ∙ 𝐹 ∙ 𝐶 

where: 

• IA and IP are the anterior and posterior measured counts 

• eµt is the attenuation map for attenuation correction with µ being the linear attenuation 

coefficient and t the patient thickness, 

• f is the self-attenuation correction factor 

• F is the background correction factor 

• C is the calibration factor (based on whole body or vial) 
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Correction of What is it? What needs to be done by 
the user? 

How is it applied 
to the data? 

Attenuation The patient body absorbs partially the 

radioactivity from the source(s) before it can be 

recorded with a gamma camera. To obtain the 

attenuation effect of the body parts, 

transmission scans are typically used. A planar 

source or a scanning line source is positioned 

inside the conjugate view to homogeneously 

emit a low dose radiation. A transmission 

measurement (TR or I) with the patient present 

and a corresponding measurement without the 

patient present (blank – BL or I0) are acquired. 

Pixel-by-pixel division of the two images leads 

to a 2D attenuation map that can be applied to 

the emission data according to equation 3 of 

the MIRD Pamphlet No. 16 (Siegel et al. 1999): 

Τ =  
𝐼

𝐼0
=  𝑒−µ𝑒𝑡 

• Load transmission and 

blank image of the patient 

• Coregister the trans-

mission image to the 

emission images of all 

time points 

 

Automatically, if 

transmission and 

blank images are 

available 

Background 

activity 

Over- and underlying activity from 

neighbouring tissue will contribute to the 

counts in the ROI. A correction for this 

background is usually needed, in combination 

with attenuation correction, for an accurate 

quantification of activity without 

overestimation. To compensate this, a 

background ROI is typically used, where the 

geometry and uptake should be as close to 

the source ROI as possible. The fraction of 

counts originating from the source can then 

be calculated according to equation 6 of the 

MIRD Pamphlet No. 16 (Siegel et al. 1999): 

𝐹 = {[1 − (𝐼𝐴𝐷𝐽/𝐼𝐴)(1 − 𝑡𝑗/𝑡)] ∙ 

[1 − (𝐼𝐴𝐷𝐽/𝐼𝑃)(1 − 𝑡𝑗/𝑡)]}1/2 

This correction is applied on the ROI level 

using total activities and average organ and 

patient thickness. 

• Draw a background ROI 

near the source organ 

• Apply the background 

ROI to the intended 

source organ(s) 

• Add a patient/organ 

thickness by either: 

o Entering the 

thickness manually. 

o Deriving the thickness 

from a measurement 

in a 3D image. 

 

Automatically, if 

background ROI 

is applied to 

source organ(s) 

and a 

patient/organ 

thickness is 

available 

Source self-

attenuation 

This is a correction for the source region 

attenuation coefficient and source thickness. It 

is applicable for extended sources as opposed 

to a point source. It is implemented according 

to equation 2 in MIRD pamphlet 16. The 

implementation in QDOSE assumes as an 

approximation that the activity is distributed, 

i.e. the source is extended over the whole 

patient thickness. 

𝑓 =
𝜇𝑡

sinh (𝜇𝑡)
 

𝜇𝑡 = ln (
𝐵𝐿

𝑇𝑅
)   

It is applied on the pixel level. 

• Load transmission and 

blank image of the patient 

• Coregister the 

transmission image to the 

emission images of all 

time points 

Automatically, if 

transmission and 

blank images are 

available 
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11.2.2 3D Corrections for Volumetric mode 

Correction of What is it? What needs to be done 
by the user? 

How is it applied 
to the data? 

Background This is a recovery coefficient type of correction 

to account for the spill out from a source region 

due to partial volume effect. At the same time, 

it aims to subtract the background activity 

underlying the spilled-out activity: 

 

Acorr = Aorgan − (VActSeg − VVolSeg) ∙ ACbkg 

 

ACbkg =
Abkg

Vbkg
 

 

Aorgan  activity of organ Activity VOI 

VActSeg  volume of organ Activity VOI 

VVolSeg  volume of organ Volume VOI 

Abkg  activity of background Activity VOI 

Vbkg  volume of background Activity VOI  

• Draw a large boundary 

around the source 

organ 

• Segment a large 

Activity VOI for the 

source organ, e.g. 

tumour 

• Segment a proper 

Volume VOI of the 

source organ  

• Draw a boundary for 

the background near 

the source organ  

• Segment Activity VOI 

for the background (to 

calculate ACbkg) 

• Link background to the 

intended source 

organ(s) 

Automatically, if  

• background 

VOI segmented 

(Activity VOI) 

and 

• background 

VOI is linked to 

source 

organ(s) 

 

11.3 Organ Table 

The table Organs displays the organs available for each mode. The organs available are depending 

on the images loaded to the system as well as the available ROIs/VOIs. The table gives an overview of 

the performed curve fitting, selected reference time point (if multiple available), if the time-activity-curve 

(TAC) is to be drawn and the cumulated activity Ã. 

 

Figure 30: Table Organs with example organs. 
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• Column Organ: Displays the organ name 

• Column Curve Fitting: Displays the curve fit type selected in the Curve Fitting Step (see 11.6) 

• Column Ref: Displays the selected 3D reference time point used for TAC calibration in Hybrid 

mode, to get the patient-specific mass of the organ which was defined during 3D segmentation 

and to obtain the activity distribution for Voxel S. 

• Column Mass: Displays the mass of the organ.  

• Column Source: Displays the source of the mass for the organ. Available options are: 

o N/A: no source available 

o IDAC2: default mass from the IDAC-Dose 2.1 dose calculator 

o 3D: mass taken from the 3D volume segmentation 

o Edited: mass was edited using in the window Organ Properties  

o OM+OM: organ mass was calculated from the sum of the left and right counterpart 

organs (e.g. L-Kidney + R-Kidney) 

o OM*2: organ mass was calculated by doubling the mass of one of the counterpart 

organs 

Note: For paired organs the mass is calculated depending on the available organ masses 

of the left and right counterpart organs in the respective dosimetry mode, see Appendix 

19.4 for detailed information. 

 

• Column TAC: The user can select whether the TAC for the organ should be displayed in the 

TAC overview. 

• Column Ã(MBq*h): Displays the cumulated activity (in exponential notation, 4 decimal places) 

of the organ that was calculated during the Activity Integration step (see 11.6). 

Note: For paired organs the cumulated activity is calculated depending on the available 

activities of the left and right counterpart organs in the respective dosimetry mode, see 

Appendix 19.5 for detailed information. 
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11.4 Add New Organ 

QDOSE makes it possible to add organs with corresponding data manually without the need of imaging 

data. This option can be used if the organ data has been acquired by other means e.g. blood sampling. 

 

Figure 31: Window Add Organ. 

 

1. Click on the button Add new organ below the table Organs. The window Add Organ opens. 

2. Click on the button Create … in the upper center of the window Add Organ. 

3. Select a predefined organ name from the dropdown list or select New… and enter an organ 

name. 

4. To confirm, click the button Create. 

5. Enter or edit the organ mass (OM); Organ masses used by the phantoms from IDAC-Dose 2.1 

(ICRP 110) are displayed by default in the table IDAC DOSE in column Mass (g). Organ 

masses differ between female and male and are automatically set according to the sex 

specification in the case. 

6. There are 3 ways to enter information about additional organs in the window Add Organ. 

• Precalculated Ã: Allows you to enter a cumulated activity Ã (MBq*h), if the value was 

calculated elsewhere. Tick the checkbox Precalculated Ã to use this option and enter 

the value in the field Ã (MBq*h). If this option is selected, curve fitting will not be possible 

for this organ. 

Note: The precalculated cumulated activity Ã is the same for all Modes (Planar, Hybrid, 

Volumetric). The cumulated activity will not be reset after changing case information like 
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e.g. calibration method or adding/deleting of image data. Only changing nuclide 

information (case nuclide or replacement nuclide) will reset the cumulated activity of 

added organs (see section 5.4 and 11.8). 

• Time-Activity Values: 

• In the table, enter the time point, date, time and activity manually by clicking into the 

table. 

• It is also possible to import a TAC from a CSV file, where each time point is saved in a 

separate line as: yyyymmdd,hhmm,activity  

Note: It is not possible to enter Time-Activity values for left or right organs. Externally added 

left/right organs can only be added by entering Precalculated Ã. 

7. Click the button Create to create the new organ. 

 

11.5 Organ Properties 

 CAUTION 

Editing organ properties may influence the dose calculation. 

Changing organ properties affecting the previously calculated TACs or Ã, will reset the curve fitting. 

 

 CAUTION 

Patient and Organ Thickness influence the dose calculation. 

If the patient and/or organ thickness were edited in the window Organ Properties, the edited values 

will be used for background correction of planar data for further dose calculations in planar or hybrid 

mode. 

 

NOTICE 

Organ masses influence the dose calculation. 

Organ masses (OM) will be used with the following priority: 

1. OM edited by user (via window Organ Properties) 

2. OM from VOI segmentation step 

3. Default organ mass from IDAC-Dose 2.1. 

The organ masses are converted to volumes by using the density values as described in 

Appendix 19.6. 
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Figure 32: Window Organ Properties. 

 

1. Select an organ from the table Organs. 

2. Right-click on the selected organ and select the option Organ Properties from the options list.  

3. Edit the following properties:  

• Color: Choose an organ color from the dropdown menu. 

• Patient / Organ Thickness (mm): Define the patient / organ thickness in millimeters using 

the entry field. The entered values will override the values from the measurement in the 

window VOI Segmentation if available. The changes can be undone by clicking the button 

Reset thickn.... 

• User defined mass (g): Define the organ mass. The entered values will override the 

default organ mass or measured organ mass from the window VOI Segmentation if 

available. The changes can be undone by clicking the button Reset mass. 

• Planar: Select a time point for a planar image from the dropdown menu to display 

information about the organ at this time point. 

• Volumetric: Select a time point for a NM image from the dropdown menu to display 

information about the organ at this time point. 

4. Confirm the changes by clicking on the button Save. 
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11.6 Curve Fitting and Activity Integration 

 CAUTION 

Incorrect units can result in incorrect dose calculation. 

For hybrid mode, the activity values in the table Organ in the window Curve Fitting are in arbitrary 

units. 

 

Curve Fitting allows fitting an analytic function to the measured data points to create a time-activity-

curve (TAC). Activity Integration allows calculation of the cumulated activity by integrating the area 

under the curve (AUC). 

The window Curve Fitting provides following functionality: 

• Different curve fitting models (monoexponential, biexponential, triexponential) 

• Defining start parameters for the curve fit 

• Exclusion of data points for curve fitting and activity integration. 

• Activity integration using different means. 

 

Figure 33: Window Curve Fitting. 

 

1. Select an organ from table Organs in the window Dose Analysis. 

2. If necessary, select a reference time point using the dropdown menu in the column Ref. in the 

table Organs.  
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• For Planar, Hybrid and Volumetric mode: the reference defines the time point in 3D to 

be used as source for the organ mass. The segmented volume of this time point is 

converted into an organ mass. 

• Special for Hybrid mode: the reference also defines the time point to be used for 

calibration of the TAC. The time point is indicated by a circle in the TAC, see Figure 

34. 

 

Figure 34: TAC in Hybrid mode calibrated to the second time point, which is indicated 
 by the circle. 

3. Click on the button Curve Fitting or right-click on the selected organ and select Curve Fitting 

from the options list. A separate window Curve Fitting is opened. 

4. If necessary, exclude single time points from curve fitting and/or activity integration separately 

by clicking the corresponding checkboxes in the columns Curve Fitting and Integration in the 

table Organ. 

5. Select the curve fit type from the dropdown menu Fit Type in the panel Curve Fitting. Available 

curve fit types are: 

• Monoexponential: consists of one exponential function 

• Biexponential: consists of two exponential functions 

• Triexponential: consists of three exponential functions 

6. If necessary, edit the start parameters for the curve fit (A, B, C, a, b, c) by using the 

corresponding fields. By ticking the checkbox behind the parameter, the displayed value will be 

fixed and not be further optimized during the curve fitting. Only unchecked parameters will be 

optimized during the curve fitting. 

7. Click on the button Update Curve Fit to apply the changes. 

The curve fit result together with the data points are displayed in the graphic below. 

Parameters for the Goodness of Fitted Curve are displayed below and indicate the following 

characteristics: 
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• SSE: Sum of squares due to error. This measures the total deviation of 

the response values from the fit of the response values. 

• R square: Square of correlation between response values and predicted 

response values and is therefore a measure of how good the fit 

explains the variation of the data. 

• DFE: Degree(s) of freedom in the error. 

• Adjusted R square: R square adjusted by the residual degrees of freedom 

• RMSE: Root mean square error 

• AIC: Akaike information criterion. This is a means for model selection 

used in the curve fit. 

• AICc: AIC with correction for small sample sizes. 

 

8. Select the calculation method for the calculation of the cumulated activity in the panel Activity 

Integration. The integration is divided up in 3-time intervals with different available integration 

methods: 

• 0 … 1: Interval from time point of injection to the first measurement time point 

- Linear: uses linear increasing activity from 0 to the first measurement time point. 

- Constant: uses a constant activity between 0 and first measurement time point that is 

equal to the activity of the first data point. 

- Analytic: uses the analytic curve fit result. 

- Exclude: excludes this interval from activity integration. 

• 1 … n: Interval from first measurement time point to last measurement time point 

- Numeric: uses numeric integration of measurement data. 

- Analytic: uses the analytic curve fit result. 

- Exclude: excludes this interval from activity integration. 

• n … Inf: Interval from last measurement time point to infinity 

- Analytic: uses the analytic curve fit result. 

- Decay only: uses specific physical half-life of the nuclide. 

- Exclude: excludes this interval from activity integration. 

Note: For each interval, the area under the curve (AUC in MBq*h) and the fraction of each 

interval are displayed in the table Activity Integration, in the columns AUC (MBq*h) and 

Fraction. 

9. Confirm the TAC and AUC calculations by clicking on the button Save. 

 



   

   

QDOSE v1.2.12, User Manual  Page 84 of 123 

11.7 Dose calculation 

11.7.1 IDAC Dose Calculation 

 CAUTION 

Dose calculation differs between IDAC-Dose 1.0 and IDAC-Dose 2.1. 

IDAC-Dose 1.0 and IDAC-Dose 2.1 use different source and target organs. Please refer to section 

19.1 for detailed information about source organ conversion between IDAC-Dose 2.1 and IDAC-

Dose 1.0. User defined organs may not be included as source organs into the dose calculation. 

Always check the input to IDAC-Dose calculation by clicking the button Input data. 

 

NOTICE 

Specific organ mass only considered for self-dose 

The patient specific mass (measured mass from Volume segmentation, edited mass) of a source 

organ can also be used for dose calculation with IDAC-Dose. The patient specific mass is only 

considered for calculation of the self-absorbed dose of the source organ. In case the source organ 

has no cumulated activity and therefore is not considered for dose calculation (check via button 

Input data), the patient specific mass has no effect on the dose. 

 

NOTICE 

Salivary glands not calculated automatically 

Different salivary glands can be segmented in the image data (L-Parotid gland, R-Parotid gland, L-

Submaxillary gland, R-Submaxillary gland, L-Sublingual gland, R-Sublingual gland). The single 

salivary glands are not automatically considered for IDAC dose calculation. If salivary glands should 

be considered as input for IDAC dose calculation, the organ Salivary glands has to be added 

manually (Add new Organ). The cumulative activity for salivary glands can be entered using the 

information from the single salivary glands. Always check the input to IDAC-Dose calculation by 

clicking the button Input data. 
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NOTICE 

User-defined organs and tissues are not considered for remainder body calculation 

The activity for ‘Remainder’ is calculated by subtracting the organ activities from the ‘Total Body’ 

activity. Only the activities of organs defined within the phantom (e.g. IDAC 2.1) are considered for 

the calculation of the ‘Remainder’ activity, but not the activities of additional user-defined structures, 

such as tumour lesions. To check which cumulated activities of organs and remainder body are 

used for the IDAC Dose calculation, use the button Input Data. 

 

IDAC dose calculations can be performed using either IDAC-Dose 1.0 or IDAC-Dose 2.1 (Andersson 

et al., 2017). 

 

 

Figure 35: Tab ICRP - IDAC-Dose in the window Dose Analysis. 
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1. Select the tab ICRP – IDAC-Dose. 

2. Select the intended version of IDAC-Dose from the options panel: IDAC-Dose 1.0 or IDAC-

Dose 2.1 

3. Select a phantom from the dropdown menu Select Phantom. 

If you want to patient-specific organ masses for source organs, please tick the checkbox in 

column Patient Specific in the table Doses for those organs. 

4. Click on the button Calculate to calculate the absorbed doses and effective doses which are 

displayed in the lower table. The calculation uses only valid source organs as input. The dose 

values are in exponential notation (4 decimal places). 

5. Click on the button Input data to check which organs from the table Organs are used for dose 

calculation. 

 

11.7.2 Voxel S 

 CAUTION 

Voxel S dosimetry of lung, bone or bone lesions results in incorrect values. 

Voxel S kernels are only valid for soft tissue. Voxel S dose calculations for other tissues such as 

bone or lung are not valid. Furthermore, the user must decide how meaningful Voxel S dose 

calculations are for their specific image data as the activity distribution used as base for calculation 

may be incorrect due to partial volume effect. 

 

NOTICE 

Voxel S is only available in Hybrid and Volumetric mode. 

Segmentation of organs has to be performed on 3D data sets (PET or SPECT images). 

 

Voxel S calculation computes the self-absorbed dose for an organ based on the activity distribution in 

the volume segmentation of the selected reference time point. The dose values are in exponential 

notation (4 decimal places). 

The range of supported voxel sizes is attached in Appendix 19.3. 
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Figure 36: Tab Voxel S in window Dose Analysis. 

 

1. Select the tab Voxel S. 

2. Tick the checkbox in column Calc. in the table to run the Voxel S calculation for the selected 

organ. 

The region statistics for each organ are displayed in the dose table, and the cumulative dose 

volume histogram (DVH) is displayed. 

3. Tick the checkbox in column D.I. in the table to display the dose image as slices. 

4. Hover over the dose image on the right side to display the dose value of the corresponding 

pixel. The slice can be changed using the slider Slice and the lower and upper threshold can 

be adjusted using the sliders LT and UT. 
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11.7.3 Spherical Model 

 CAUTION 

Using the spherical model for non-spherical organs may result in incorrect doses. 

It is the responsibility of the user to judge whether it is correct to assume a spherical shape for an 

organ or a structure for dose calculation.  

 

Absorbed doses are calculated for the defined organs based on a spherical model approach (Stabin 

and Konijnenberg, 2000), which calculates the absorbed doses for a number of predefined sphere 

masses. For the specific organ masses, the dose is calculated in QDOSE by interpolation of the 

volume/mass by a power function. 

 

 

Figure 37: Tab Spherical Model in window Dose Analysis. 
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1. Select the tab Spherical Model. 

2. Select if only the user-defined organs, such as a tumour, should be shown, by ticking the 

checkbox Only User Defined Organs. 

3. The dose calculation results are shown in the resulting table. The dose values are in 

exponential notation with 4 decimal places. 

 

11.7.4 Export to OLINDA/EXM 1.1 

NOTICE 

Source organs of OLINDA EXM 1.0, IDAC-Dose 1.0 and IDAC-Dose 2.1 are defined 

differently. 

In some cases, OLINDA EXM 1.0 and IDAC-Dose 1.0 and IDAC-Dose 2.1 use different definitions 

of organs.  

• The organs "Right colon contents (RC)", "Left colon contents (LC)" and "Rectosigmoid colon 

contents (RSC)" are used by IDAC-Dose 2.1 and are the default organs in QDOSE. If any 

or all of these source organs exist, the OLINDA source organs "ULI contents" and "LLI 

contents" are created and Ã will be calculated according to:  

o ULI = RC + 0.478873 · LC  

o LLI = RSC + 0.521127 · LC 

• If the organs "Uterus/cervix" and "Uterus" both exist, the OLINDA export will use "Uterus" 

and ignores "Uterus/cervix".  

• If the organ "LLI" exists, but also "RC" and/or "RSC", OLINDA export will use the organ 

"LLI" and does not calculate the Ã based on "RC" and "RSC".  

• If the organ "ULI" exists, but also "RC" and/or "LC", OLINDA export will use the organ "ULI" 

and does not calculate the Ã based on "RC" and "LC". 

The user should check which organs were used for model-based dose calculations by clicking the 

button Input data in the window Dose Analysis. 

 

Calculated residence times can be exported into an OLINDA 1.1 case file to be used for dose calculation 

within OLINDA. The values to be exported to OLINDA/EXM 1.1 (Stabin et al. 2005) are displayed in the 

table. 
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Figure 38: Tab Export to Olinda 1 in window Dose Analysis. 

 

1. Select the tab Export to Olinda 1. 

2. Select the phantoms to be exported by ticking the corresponding checkbox in panel Phantoms. 

3. Click on the button Export to file and select a target file in the dialog window. 

 

11.8 Replacement Nuclide / Dose Extrapolation 

 CAUTION 

Nuclide replacement is only valid for identical biological behaviour. 

The methodology applied for nuclide replacement assumes that the biological behaviour of a 

radiopharmaceutical is identical for the original nuclide/isotope and its replacement. Differences in 

calculated biological half-lives originate from uncertainties of the curve fitting. Activities and 

cumulated activities are scaled linear with the extrapolated activity. 
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 CAUTION 

Image data with original nuclide must be suitable for nuclide replacement. 

Image data with the original nuclide must ensure to capture the complete biological behaviour of 

the radiopharmaceutical for the organs/tissues of interest, otherwise the results with the 

replacement nuclide might not be reliable. Negative biological half-lives after nuclide replacement 

need to be investigated and might be a hint that further imaging is required to completely retrieve 

the biological behaviour of the radiopharmaceutical for a specific organ/tissue.  

 

 CAUTION 

Nuclide replacement may enhance the effect of inaccuracies in fitted pharmacokinetic 

parameters. 

Replacing a nuclide for another one with a significantly different half-life (e.g. much longer half-life) 

may result in over- or under-estimation of the absorbed doses for organs/tissues for which the actual 

pharmacokinetics of the organ/tissue cannot be completely and accurately determined from the 

available image data.  

 

 CAUTION 

Dosimetry of replacement nuclide must always be verified. 

Dosimetry using a replacement nuclide does not replace performing the dosimetry with the 

replacement nuclide directly or verifying the results with a different method. The results should only 

be used as a rough estimate of the doses and should not be used to determine patient safety. 

 

 CAUTION 

Changing nuclide will reset added organs with precalculated Ã. 

Additional organs with precalculated Ã can be added in Dose Analysis window. The cumulated 

activity of those organs will be reset after changing the nuclide. Always check the input to IDAC-

Dose calculation by clicking the button Input data. 

 

It is possible to perform a nuclide substitution using QDOSE. The TACs of the organs are automatically 

corrected for physical decay of the original nuclide to the time of injection, leaving only the biological 

clearance. In a second step, the physical decay of the replacement nuclide is applied to the TACs. 
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Curve fitting and dose calculation can then be performed for the replacement nuclide. In addition, or 

alternatively, the user can enter an extrapolated activity for dose extrapolation. 

 

1. Select a replacement nuclide from the dropdown menu in the panel Replace Nuclide (see 

Figure 29). 

2. Enter a value for the extrapolated Activity in MBq in entry field. 

3. Perform curve fitting and activity integration again for this nuclide. 

4. Click the button Reset in order to reset the calculations to the original values. 
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12 Dose Analysis SIRT/MAA  

Dose Analysis SIRT/MAA allows dose calculation using Voxel S, injected activity prediction and 

report generation/value export. 

 

 

Figure 39: SIRT/MAA Flowchart. 
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12.1 Setting up the Case 

NOTICE 

Only one pre- and one post-treatment data set can be evaluated per case. 

It is only possible to assign one NM image data set to analysis group PRE and one NM image data 

set to analysis group POST in the scope of one case. 

 

1. Create a case as described in section 5.3. In the window New Case select the option 

MAA/SIRT in the dropdown menu Mode. 

2. Load the image data to the case as described in section 5.1 step 2. 

3. After loading the image data to the case, open the window Edit Case. 

4. For NM data sets, define the analysis group in the table NM Images from the dropdown menu 

in column Analysis Group. Available options are: 

• PRE: Pre-treatment SPECT image data. 

• POST: Post-treatment PET image data 

• CT/MR: Only additional morphological image for improved organ segmentation. 

• N/A: not applicable. 

 

12.2 Coregistration and Volume Segmentation 

The steps of 2D ROI Drawing, 3D Coregistration and VOI Segmentation are the same as for the other 

workflows. Please refer to the corresponding sections 7, 9 and 10 on how to proceed. 

 

12.3 Dose Calculation 

 CAUTION 

Incorrect organ segmentation results in incorrect dose values. 

Only the segmented volume (see Volume Segmentation, section 10.3) is to be used for dose 

analysis. 
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NOTICE 

Pre-treatment dosimetry based on 90Y Voxel S kernel 

It is possible to perform pre-treatment dosimetry (99mTc-MAA-Scan). Pre-treatment dosimetry is 

based on the 90Y Voxel S kernel. 

 

 

Figure 40: Window Y90 Voxel S for SIRT dose analysis. 

 

1. Select the analysis group in the dropdown menu on the upper left corner of the window Y90 

Voxel S: PRE, POST or PRE vs POST. 

2. Select the image modality from the drop-down menu in the left upper corner of the panel Image: 

NM, CT or Fused. 

3. Select the colour map for the selected modality from the lower dropdown menu in panel Image.  

4. Select the windowing for image view. Depending on the image modality different windowing 

options are available: 

Select the windowing for CT/MR images in the panel Image (see Figure 40): 

• Window: In the upper drop-down menu, a window can be chosen from a list of 

predefined windows. The syntax is defined as window width/window center in 

Hounsfield Units (HU) (e. g. 300/40 means a window with a width of 300 HU around a 

center of 40 HU. 

• U/C: slider for fine adjustment of window center C 
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• L/W: slider for fine adjustment of window width W 

Select the windowing for NM images in the panel Image (see Figure 40): 

• The windowing can be adjusted using the sliders for U/C (Upper Threshold U) and L/W 

(Lower Threshold L). 

For mode Fused, the windowing options are disabled as the settings from the single modalities 

are used. The alpha blending between the two images can be adjusted using the slider Alpha. 

5. Select the intended organ from the table Organs for which dose calculation is to be performed. 

6. Start the calculation by ticking the checkbox in column Calc & view in the table Organs. 

7. Tumours can be excluded from the parent (treated liver) organ to determine the absorbed dose 

to the healthy treated liver tissue. In addition, the treated liver tissue can be excluded from its 

parent liver to calculate the dose to the untreated part of the liver. In order to do so, tick the 

checkbox in column Exclude from parent in the table Organs. 

8. The cumulated dose volume histogram (Cumulative DVH), dose image and dose statistics 

table for the organs are calculated and displayed. 

9. Tick the checkbox of the intended organ in column Isocontour in the table Organs to display 

the isocontours in the dose image. The Isodose levels can be adjusted in the entry field Isodose 

levels in panel Image. 

 

12.4 Dose Prediction 

The tool Dose Prediction allows predicting the dose to each organ based on the user-defined 

extrapolated activity. 

1. Enter the extrapolated activity for the treatment in MBq in the panel Dose prediction in the 

field Extrapolated Activity, in the window Dose Analysis. 

2. The absorbed dose values are recalculated and updated in the dose statistics table, dose image 

and graphics for the cumulative DVH. 

 



   

   

QDOSE v1.2.12, User Manual  Page 97 of 123 

12.5 Injected Activity Prediction 

 CAUTION 

Activity Prediction tool is not intended to be used clinically. 

The Activity Prediction tool is not intended to be used to make decisions for clinical use (e.g. 

treatment planning). It is for research purposes only. Different calculation methods can result in 

different calculated activities. Treatment should not be planned based on the displayed values. 

Instead, the instructions of the manufacturer of the spheres should be used. 

 

NOTICE 

Incorrect naming of organs influences calculations. 

The segmented tumour volume and activity must contain the word ‘tumour’ or ‘tumor’ in order to be 

taken into account for activity prediction. 

 

NOTICE 

Definition of analysis groups influence initial values for activity prediction. 

If no PRE or POST analysis group is defined values for volumes and activities are taken from the 

first data set. 

 

The tool Injected Activity Prediction allows predicting the activity that needs to be injected in order to 

get the intended activity to the liver. The calculation can be performed using different calculation 

methods and limiting factors such as dose values for specified organs. 
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Figure 41: Window Activity Prediction. 

 

1. Click on the button Activity Prediction in lower left corner of the window Dose Analysis. The 

window Activity Prediction opens (see Figure 41). 

2. In the panel Organ Data, the volumes and activity values for the Liver and Tumours are 

displayed, which were obtained from the VOI segmentation. The lung shunt fraction is 

calculated in the field Lungs shunt fraction [%]. These values can be edited using the 

corresponding field and pressing Enter. 

Note: If you want to undo any editing, click on the button Reset to original. 

3. After entering all input values, the calculation method can be chosen. The injected activity can 

be predicted for SIR-spheres (Sirtex Medical Limited, Australia) or Theraspheres (BTG 

International Limited, United Kingdom). For SIR-spheres the following methods are available: 

• Empirical method 

• BSA method: Body Surface Area (BSA) and modified BSA (SMAC) method 

• Partition method 

A separate calculation method is available for Theraspheres in panel Theraspheres. 

In addition, activity prediction using Voxel S is available for both sphere types in panel Voxel S. 

The user can define calculation constraints based on the dose for organs in the fields: Absorbed 

dose – lungs [Gy], Absorbed dose – healthy treated liver [Gy] and Desired Tumor Dose [Gy]. 

Confirm by pressing Enter. 



   

   

QDOSE v1.2.12, User Manual  Page 99 of 123 

4. The resulting values for the predicted activity for injection are displayed in the field A [GBq] in 

each panel in the field Activity Prediction. 

Note: For the method Voxel S, the injected activity will be calculated using the Voxel S 

dosimetry results. The displayed injected activity corresponds to the more restricting absorbed 

dose value (healthy treated liver or tumours). This method requires prior Voxel S dose 

calculation including the healthy treated liver (with the tumour excluded from the parent treated 

liver). 
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13 Reporting 

The automatically generated report combines the results of all evaluation steps in an overview 

document. It is also possible to export a variety of results tables in CSV format for further processing. 

 

13.1 Report Generation 

The generated report is based on KeV Medical Imaging’s generic template. To be able to generate a 

report, the curve fitting step must have been performed, first. 

 

Figure 42: Window Report. 

 

1. In the window Patient Browser, click on Report in the file menu and select Generate Report. 

The window Report opens. 

2. Select the dosimetry workflow to generate report for from the dropdown menu Report 

depending on the available data: Planar, Hybrid, Volumetric, SIRT. 

3. Enter the author name, organization (optional), and study in the fields Author, Institution and 

Study. 

4. Click on the button Generate and select the target file from to save as a PDF file. The precision 

in the report is 2 decimal places for IDAC Dose (1.0 & 2.1) and Spherical Model, and 3 decimal 

places for Voxel S. 

 



   

   

QDOSE v1.2.12, User Manual  Page 101 of 123 

13.2 CSV Export 

 CAUTION 

Processing of exported values can lead to different results. 

The format of the exported values using the CSV Export tool may differ from the PDF report. Further 

processing of the exported values with other software may lead to different results than those 

displayed in QDOSE. The user must check the correctness of the exported values especially when 

using the exported values for further post-processing. 

 

1. Click on the icon Save CSV File  in the toolbar of the window Dose Analysis The window 

Report opens. 

2. Select the data to be exported as a CSV file from the upper dropdown menu. 

3. Click on the button Export and select the target file from to save as a CSV file 

Note: If the full table is selected, the listed individual tables are combined to contain all the information 

in one table. 

 

13.3 Notes 

Notes by the user can be added to the case which will be printed along with the report. 
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Figure 43: Notes Window. 

 

13.3.1 Add Notes 

1. Click on the icon Add Notes  in the toolbar of any window or use the file menu in the Patient 

Browser by clicking on Report > Notes. 

2. Type the note in the corresponding text field. The date, time and current username are 

automatically entered. 

3. Click on the button Add Note. The note is saved and displayed in the list. 

 

Note: Entered notes are available even when case is not saved. 

13.3.2 Delete Notes 

1. Select a note in the Notes window. 

2. Click on the button Delete Note. 

3. Confirm deletion of the note. The note is deleted and is removed from the list. 

 

Note: Deleted notes are no longer available even when case is not saved. 
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14 User Management 

The user management tool allows to create and manage users with different roles (user and admin) 

to authorise functionalities and to authenticate users before accessing the program. The username 

of the current active user is also saved as author when creating notes to a case. 

 

 

Figure 44: Window User Management. 

 

14.1 Creation of users 

14.1.1 User roles 

In QDOSE, two different kinds of user roles are available: user and admin (abbreviation of administrator 

user). These roles can be discriminated by the actions they are authorised to perform, see Table 1. 

 

Table 1: Authorised actions for user roles 

Role  User  Admin 

Perform dosimetry ✓  ✓  

Reset own password ✓  ✓  

Set/reset other users’ and admins’ password  ✓  

Create, delete, manage users and admins  ✓  

Manage/change users database  ✓  
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14.1.2 Login credential requirements 

Usernames must be compliant to the following requirements:  

• at least one character, maximum 50 characters, 

• usernames must consist of following characters only: A-Z; a-z; 0-1, - (minus) and 

_ (underscore); no special characters are allowed. 

 

Passwords must be compliant to the following requirements: 

• at least 8 characters, maximum 50 characters, 

• at least one digit, 

• at least one uppercase character, 

• at least one lowercase character, 

• following characters are allowed: A-Z; a-z; 0-1, - (minus) and _ (underscore); no special 

characters are allowed. 

14.1.3 Create admins 

NOTICE 

One-time super admin token is only valid once. 

The super admin token is a one-time token. It is consumed by first creation of an admin. Then the 

‘SuperAdmin’ account is deactivated. In case all admin accounts were deactivated, they can only 

be reactivated by a super admin. A new license with a new one-time token needs to be generated 

by QDOSE support. The new license needs to be imported into QDOSE. Then one-time access by 

the super admin account is possible. After reset of admin passwords, the super admin is deactivated 

again. 

 

NOTICE 

Create an admin account for backup. 

In case an admin has forgotten his/her password, the account can only be reactivated, and the 

password can only be reset by another admin role. 

It is recommended to create at least two admin accounts and save the credentials of one admin 

account as a backup. Store the backup admin account credentials in a save and restricted location, 

e.g. a password safe. Accounts will not become invalid after time. 

 

For the first set-up of users, the authenticated ‘SuperAdmin’ has to create at least one admin. Further 

administrators or users can then be created by ‘SuperAdmin’ or any other admin.  
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Once an admin was created by the ‘SuperAdmin’, the 'SuperAdmin' account is deactivated. The 

‘SuperAdmin’ can continue the session but cannot login again. 

 

Only admins and the ‘SuperAdmin’ are authorised to create users. 

In order to create an admin, follow these steps: 

1. Click on Tools > User Management. The window User Management opens (see Figure 44) 

without any contents. 

2. Click on the button New User, if necessary. 

3. Enter a Username compliant to the requirements in chapter 14.1.2. 

4. Enter a Password compliant to the requirements in chapter 14.1.2. 

5. Select the role “Admin” from the dropdown menu Role. 

6. Set account to active in checkbox Activity, if necessary. 

7. Enter a comment (optional). 

8. Click on button Save. 

9. The user is created and displayed in the list of Users on the left side of the window. 

14.1.4 Create users 

In order to create users, follow the same steps 1 to 9 as described in section 14.1.3, except for selecting 

the role “User” in step 5. 

 

 

14.2 Maintaining and authorization of users 

14.2.1 Reset passwords 

Only admins are authorised to reset passwords for other users and admins.  

In order to reset a password, follow this instruction: 

1. Click on Tools > User Management. The window User Management opens (see Figure 44). 

2. Select the name of the account from the list Users which needs to be reset. 

3. Click on the button New Password. 

4. Enter a new password compliant to the requirements in chapter 14.1.2. 

5. Confirm by clicking OK. 

6. Click on button Save. 

14.2.2 Activate/Deactivate users 

An activated user has access to the software tool after successful authentication (login), while a 

deactivated user does not. After three failed login attempts a user account is deactivated automatically. 

Only admins are authorised to activate and deactivate other users and admins.  
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In order to activate/deactivate, follow this instruction: 

1. Click on Tools > User Management. The window User Management opens (see Figure 44). 

2. Select the name of the account from the list Users which needs to be activated/deactivated. 

3. Click inside the checkbox Activity to activate (enabled checkbox) or deactivate (disabled 

checkbox) the account. 

4. Click on button Save. 

 

14.2.3 Delete users 

Only admins are authorised to delete users and admins.  

In order to delete an account, follow this instruction: 

1. Click on Tools > User Management. The window User Management opens (see Figure 44). 

2. Select the name of the account from the list Users which needs to be deleted. 

3. Click on the button Delete user. 

4. Click on button Save. 

 

14.2.4 Changing Users Database Path 

Changing of users database can only be performed by admin. In order to change the location of the 

users database, the user has to copy and paste an existing database to the new intended location. By 

default the users database is created under: 

‘C:\ProgramData\QDOSE\QDOSEUsers.db7’. 

 

To change the path, please follow these steps: 

1. Copy the file ‘QDOSEUsers.db7’ from the folder ‘C:\ProgramData\QDOSE\’. 

2. Paste it to the new location. 

3. In window QSettings select the new location under Users DB Path by clicking on the button 

Browse and select the corresponding file on the file system. 
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14.2.5 Maintaining users for multiple installations 

 CAUTION 

Simultaneous changes to the database might be lost 

The user database should only be accessed by one admin at a time. Simultaneous changes to the 

user management might lead to data loss on the user management that was opened as second 

instance. Save changes immediately and do not leave the user management open for a longer 

period of time. 

 

NOTICE 

Import of a new license will reset only the super admin token of the master license. 

When importing a new license, only the one-time super admin token of the master license will be 

reset. One-time super admin tokens of sublicenses that use the same users’ database will not be 

reset. 

 

For the use case that multiple QDOSE installations with separate licenses want to use the same users’ 

database, an admin can set-up a common shared users database. 

One license will act as the master of that database while the other licenses are sublicenses of that 

database. 

In order to set-up a common shared database for multiple QDOSE installations, follow these instructions 

carefully: 

1. Identify the system on which the master license is activated by clicking on Help > License in 

the Patient Browser. 

2. The license details will be displayed. In the tag User DB Master either ‘0’ or ‘1’ is displayed: 

• ‘0’ indicates that this license is a sublicense. 

• ‘1’ indicates that this license is a master license. 

3. Once you have identified the master license system as in step 2, you can set-up the users and 

admins in window User Management on this system. If you have already set-up all accounts, 

continue with step 4. 

4. In window QSettings, check the location of the users database in the field Users DB Path. 

The default location is: ‘C:\ProgramData\QDOSE\QDOSEUsers.db7’. 

5. Copy the file ‘QDOSEUsers.db7’ from the folder ‘C:\ProgramData\QDOSE’. 

6. Paste it to the new location where all intended systems with their users have access. Please 

check access rights (reading and writing rights) on the file system beforehand and adapt if 

necessary. 

7. In window QSettings select the new location under Users DB Path by clicking on the button 

Browse and select the corresponding file on the file system. 

8. Identify the system on which the sublicense is activated as described in step 2. 
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9. On this system, again select the new location in window QSettings under Users DB Path by 

clicking on the button Browse and select the corresponding file on the file system. 

10. Repeat steps 8 and 9 for all systems on which sublicenses are activated. 

 

14.3 Best practices 

1. Set strong passwords to protect sensible patient health data from unauthorised access. 

Password recommendations [German Federal Office for Information Security, BSI]: 

• Rule 1: The longer the better! 

• Rule 2: Easy to remember! 

• Use all available characters and symbols. 

• Tip: Take a sentence and use the first character of each word for your password. One 

can also replace number words by digit characters. 

• Do not use popular weak passwords like ‘123456’ or ‘qwert’. 

• Do not us names of family members, pets, best friends, popular stars, birth dates and 

so on, because they can easily be guessed. 

• Use a password manager or password safe to manage different passwords securely. 

 

2. Create a backup admin account. 

In case an admin has forgotten his/her password, the account can only be reactivated and the 

password can only be reset by another admin role. It is recommended to create at least two 

admin accounts and save the credentials of one admin account as a backup. Store the backup 

admin account credentials in a save and restricted location, e.g. a password safe. Accounts will 

not become invalid after time. 

3. Ask users and admins to change their password after first set-up. 

Always request users and admins to change their password after it was created by an admin 

to prevent breach of privileges. 
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15 User Authentication 

15.1 Login 

NOTICE 

Account will be deactivated after to many failed login attempts. 

If a user enters a wrong password three times in a row, the account is automatically deactivated 

and needs to be activated again by an admin, see chapter 14.2.2.  

 

After start of the application, a login window appears, see Figure 45.  

In order to authenticate: 

1. Enter the Username and Password provided by the QDOSE admin. 

2. Click OK. 

 

 

Figure 45: Window Login. 

15.2 Change password 

If you want to change or are required to change your own password, e.g. after first login, follow these 

steps: 

1. Click on Tools > Change password. The window Old password opens (see Figure 46). 

2. Enter your current (old) password that you would like to change. 

3. Click OK. The window New password opens (see Figure 47). 

4. Enter your new password compliant to password requirements in chapter 14.1.2 and confirm 

the password. Take into consideration our password recommendations in chapter 14.3. 

5. Click OK. A dialogue window will confirm the successful change of the password. 
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Figure 46: Window Old password. 

 

Figure 47: Window New password. 

 

15.3 Change user 

In order to change to another account, you need to authenticate again. The intended account must 

already exist. Please follow these steps: 

1. Save your current case, if necessary. 

2. Go to Tools > Change user. A login screen similar to Figure 45 will appear. 

3. Enter the Username and Password provided of the account you want to change to. 

4. Click OK. A dialogue window will confirm the successful login as the new user. 

 

15.4 Session timeout 

NOTICE 

Check to save the current case before changing users and after session time-out. 

The work on the current case is not automatically saved, not even at auto-logoff or change of users, 

but must be actively saved by the current user. Note, if the user is changed after the auto-logoff, it 

must be checked if the current case needs to be saved. 

 

For security reasons, QDOSE will automatically log-out users after a defined time of inactivity. The 

access to the program is blocked and the information in the Patient Browser are hidden. Users have 

to re-authenticate to be granted access to the program again, see Figure 48. 
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Figure 48: Window login after auto-log-out and hidden information in window Patient Browser. 

 

The period of the session timeout is set to 15 minutes by default and can be adapted in the window 

QSettings under Application > Session Timeout (min), see chapter 4. 

 



   

   

QDOSE v1.2.12, User Manual  Page 112 of 123 

16 Toolbar Elements 

 
Save CSV File Export dosimetry data as CSV file 

 
Add Notes Add notes in software which are printed to the report 

(PDF) 

 
Zoom In Click on the image to zoom in step-wise 

Draw a rectangle to zoom into this section 

Right-click on the image to zoom out step-wise 

 
Reset Zoom Reset zoom to full view 

 
Pan Pan over the image by dragging the image  

 
Enable/Disable Image 

Information 

Enable/disable the display of image information 

 
Display Cross Enable/disable the display of the cross hair 

 
Display Boundaries Enable/disable the display of the boundaries (orange 

line) 

 
Display Activity 

Segmentation 

Enable/disable the display of the activity segmentation 

(yellow line) 

 
Display Volume 

Segmentation 

Enable/disable the display of the volume segmentation 

(red line) 

 
Display MIP (Maximum 

Intensity Projection) 

Enable/disable the display of the Maximum Intensity 

Projection 

 
Screenshot of Main View Make a screenshot of the figure in the main view to be 

included in the report (PDF) 

 
Enable/Disable Filter for 

Image Data 

Enable/disable the display of the filtered image 
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17 Abbreviations 

Abbreviation   Explanation 

2nd : Second (image) 

2D : Two Dimensional 

3D : Three Dimensional 

Ã : Cumulated Activity 

ANT : Anterior 

AUC : Area Under the Curve 

BL : Blank 

BSA  Body Surface Area 

CSV : Comma Separated Value 

CT : Computed Tomography 

DICOM : Digital Imaging and Communications in Medicine 

DVH : Dose Volume Histogram 

ED : Effective Dose 

EM : Emission 

FWHM  Full Width at Half Maximum 

ICRP : International Commission on Radiological Protection 

IDAC : Internal Dose Assessment by Computer 

LT : Lower Threshold 

LUT : Look Up Table 

MAA : Microaggregated Albumin 

MRI : Magnetic Resonance Imaging 

NM : Nuclear Medicine 

OM : Organ Mass 

PDF : Portable Document Format 

PET : Positron Emission Tomography 

POST : Posterior 

POST : Post-treatment 

PRE : Pre-treatment 

PSF : Point Spread Function 

ROI : Region Of Interest 

SBR : Signal to Background Ratio 



   

   

QDOSE v1.2.12, User Manual  Page 114 of 123 

SIRT : Selective Internal Radiation Therapy 

SPECT : Single Photon Emission Computed Tomography 

TAC : Time Activity Curve 

TP : Time Point 

TPI : Time Post Injection 

TR : Transmission 

UDI : Unique Device Identifier 

UT : Upper Threshold 

VOI : Volume Of Interest 

WB : Whole Body 
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18 Reporting of Events 

KeV Medical Imaging distributes QDOSE and has the responsibility of ensuring that it is working 

properly. QDOSE is fully tested and validated. There may be problems, nevertheless. 

The users must communicate issues, so that KeV Medical Imaging can perform corrective measures 

and make improvements, and, if necessary, inform other users. Please report malfunctions or changes 

in performance that may affect safety to the manufacturer or distributor. Every issue will be evaluated 

on an individual basis. In case of a serious incident, please report immediately to the manufacturer or 

distributor, and the competent authority in your country. 

Please use the following template when reporting an event or problem: 

 

Who is reporting? 

Name of Institution: 
Street: 
ZIP code/city: 
State: 
Country: 
Contact person: 
Telephone: 
Fax: 
E-mail: 
Date: 
Signature: 
 

Device Information: 

Software version or UDI: 

 

Description of Event 

 

 

 

Send notifications to 

KeV Medical Imaging 

Sokratous 3, 11147, Galatsi, Greece 

E-mail: qdose@kevimaging.gr 

Web: https:// www.qdose.net 

Telephone: +0030 2111154521 

 

 

KeV Medical Imaging will not accept hardware for safety reasons. 
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19 Specifications and Performance Characteristics 

19.1 IDAC-Dose 1.0 and IDAC-Dose 2.1 

19.1.1 Radionuclides 

The dose calculation with IDAC-Dose 1.0 and IDAC-Dose 2.1 can be performed using the following 

nuclides (depending on the software license): 

 

225Ac, 211At, 213Bi, 11C, 64Cu, 67Cu, 18F, 68Ga, 166Ho, 124I, 131I, 111In, 177Lu, 15O, 212Pb, 223Ra, 224Ra, 

186Re, 188Re, 44Sc, 153Sm, 89Sr, 99mTc, 227Th, 86Y, 90Y, 89Zr 

 

19.1.2 Conversion of Source Organs (Cumulated Activities / Residence Times) between IDAC-

Dose 2.1 and IDAC-Dose 1.0 

IDAC-Dose 2.1 IDAC-Dose 1.0 

Adrenals Adrenals  

Urinary bladder content + Urinary bladder wall Bladder cont. 

Brain Brain 

Stomach contents Stomach cont. 

SI contents SI contents 

RC cont+0.478873*LC cont ULI contents 

0.521127*LC cont+RSC cont LLI contents 

Kidneys Kidneys  

Liver Liver  

Lungs + Lung tissue + Alveolar-interstitial + Bronchi + Bronchi bound + 
Bronchi seq + Bronchioles + Bronchioles bound + Bronchioles seq 

Lungs  

Muscle Other tissue  

Ovaries Ovaries 

Pancreas Pancreas 

Red (active) bone marrow Red marrow  

Cortical bone mineral surface*1) + Cortical bone mineral volume*1) + 
Cortical bone marrow + 0.5*Cartilage + 0.5*Yellow (inactive) bone 
marrow 

Bone (cort.)*1) 

Trabecular bone mineral surface*1) + Trabecular bone mineral volume*1) 
+ Trabecular bone marrow + 0.5*Cartilage + 0.5*Yellow (inactive) bone 
marrow 

Bone (trab.)*1) 

Spleen Spleen 
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IDAC-Dose 2.1 IDAC-Dose 1.0 

Testes Testes 

Thyroid Thyroid 

Heart wall Heart wall 

Gallbladder content + Gallbladder wall Gall bl. cont. 

Stomach wall + Stomach mucosa Stomach wall 

SI wall + SI mucosa + SI villi SI wall 

RC wall + 0.478873*LC wall + RC mucosa + 0.478873*LC mucosa; ULI wall 

0.521127*LC wall + RSC wall + 0.521127*LC mucosa + RSC mucosa LLI wall 

Blood Blood  

Other + Teeth surface activity + Teeth volume activity + LN in ET region 
+ LN in sys + LN in thoracic region + LN total + ET1 Surface of anterior 
nasal passages + ET1 Surface of posterior nasal passages wall + ET2 
region Bound+ ET2 region Sequestered + ET2 + Ureters + 
Uterus/cervix + Breast + Adipose/residual tissue + Oral cavity + Oral 
mucosa + Pituitary gland + Prostate + Respiratory tract air + Skin + 
Thymus + Tongue + Tonsilsregion Surface + ET2 region wall + Eye 
lenses + Oesophagus fast + Oesophagus slow + Oesophagus wall + 
Salivary glands 

Remainder 

*1) Bone activity is typically assigned to the bone surface for nuclides/isotopes with physical half-lives 

< 15 day, while it is assigned to the bone volume for half-lives > 15 days. Therefore, a mixture of bone 

surface and volume activity should generally not occur. 

19.1.3 Conversion of Source Organs (Cumulated Activities / Residence Times) between IDAC-

Dose 2.1 and Export to OLINDA 1.1 

 

IDAC-Dose 2.1 OLINDA 1.1 

Adrenals  Adrenals  

Urinary bladder content + Urinary bladder wall Bladder cont.  

Brain  Brain  

Breasts Breasts 

Stomach contents + Stomach wall + Stomach mucosa Stomach  

SI contents + SI wall + SI mucosa + SI villi SI contents  

RC cont + 0.478873*LC cont ULI contents  

0.521127*LC cont + RSC cont LLI contents  

Kidneys Kidneys   

Liver Liver  

Lungs + Lung tissue + Alveolar-interstitial + Bronchi + Bronchi bound + 
Bronchi seq + Bronchioles + Bronchioles bound + Bronchioles seq 

Lungs  
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IDAC-Dose 2.1 OLINDA 1.1 

Muscle Muscle  

Ovaries Ovaries  

Pancreas Pancreas  

Red (active) bone marrow Red marrow  

Cortical bone mineral surface*1) + Cortical bone mineral volume*1) + 
Cortical bone marrow + 0.5*Cartilage + 0.5*Yellow (inactive) bone 
marrow 

Bone (cort.)*1)  

Trabecular bone mineral surface*1) + Trabecular bone mineral volume*1) 
+ Trabecular bone marrow + 0.5*Cartilage + 0.5*Yellow (inactive) bone 
marrow 

Bone (trab.)*1) 

Spleen Spleen  

Testes Testes  

Thyroid Thyroid  

Heart wall Heart wall  

Gallbladder content + Gallbladder wall Gall bl. cont. 

Uterus/cervix Uterus 

RC wall + 0.478873*LC wall + RC mucosa + 0.478873*LC mucosa; ULI wal  

0.521127*LC wall + RSC wall + 0.521127*LC mucosa + RSC mucosa LLI wal  

Thymus Thymus  

Other + Teeth surface activity + Teeth volume activity + LN in ET region 
+ LN in sys + LN in thoracic region  + LN total + ET1 Surface of anterior 
nasal passages + ET1 Surface of posterior nasal passages wall + ET2 
region Bound + ET2 region Sequestered + ET2 + Ureters + 
Uterus/cervix + Breast + Adipose/residual tissue + Oral cavity + Oral 
mucosa + Pituitary gland + Prostate + Respiratory tract air + Skin + 
Tongue + Tonsilsregion Surface + ET2 region wall + Eye lenses + 
Oesophagus fast + Oesophagus slow + Oesophagus wall + Salivary 
glands 

Remainder 

*1)  Bone activity is typically assigned to the bone surface for nuclides/isotopes with physical half-lives 

< 15 day, while it is assigned to the bone volume for half-lives > 15 days. Therefore, a mixture of bone 

surface and volume activity should generally not occur. In OLINDA/EXM the user can specify whether 

to assign the cumulated activity/residence time of cortical and trabecular bone to the surface or the 

volume of the bone. 

 

19.2 Spherical Model 

Spherical model calculation is available for following nuclides (depending on the software license): 

225Ac, 213Bi, 64Cu, 67Cu, 18F, 68Ga, 124I, 131I, 177Lu, 212Pb, 223Ra, 224Ra, 188Re, 99mTc, 90Y, 89Zr 

 

The spherical model can only be calculated in certain mass ranges depending on the selected nuclide. 

Following table gives an overview over ranges: 
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Nuclide Mass range (in g) 

Minimum Maximum 

225Ac 0.01 6000 

213Bi 0.1 6000 

64Cu 0.01 6000 

67Cu 0.01 6000 

18F 0.1 1000 

68Ga 0.5 6000 

124I 1 6000 

131I 0.1 2000 

177Lu 0.01 6000 

212Pb 0.01 6000 

223Ra 0.01 6000 

224Ra 0.01 6000 

188Re 1 6000 

99mTc 2 1000 

90Y 1 6000 

89Zr 1 1000 

 

19.3 Voxel S 

Voxel S dose kernels are available for following nuclides (depending on the software license): 

 

131I, 177Lu, 186Re, 188Re, 153Sm, 89Sr, 99mTc 90Y 

 

The dose kernels are based on the published kernels from Lanconelli et al (Lanconelli et al. 2012). 

Voxel S assumes a tissue density of 1.0 g/cm³. The range of voxel sizes for Voxel S calculations is as 

follows: 

 

Nuclide Voxel size (in mm) 

Minimum Maximum 

131I, 177Lu, 186Re, 188Re, 153Sm, 89Sr, 90Y 2.21 9.28 

99mTc 4.4181 
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19.4 Calculation of Paired Organ Masses 

Organ mass of paired organ Planar 

Mode 

Hybrid 

mode 

Volumetric 
mode 

Only L organ defined in 2D and 3D OML * 2 OML * 2 OML * 2 

Only R organ defined in 2D and 3D OMR * 2 OMR * 2 OMR * 2 

L & R organ defined* in either 2D or 3D OML + OMR OML + OMR OML + OMR 

‘Defined’ means that a region was drawn and activity and volume was segmented in all time points. 

**  This applies even if the L & R organs are defined in only planar or volumetric mode. Once defined, 

mass will be used in all modes. 

19.5 Calculation of Paired Organ Activity 

Cumulated activity Ã of paired organ Planar 

Mode 

Hybrid 

mode 

Volumetric 
mode 

Only L organ defined in 2D and 3D ÃL * 2 ÃL * 2 ÃL * 2 

in 2D ÃL * 2 - - 

in 3D - - ÃL * 2 

Only R organ defined in 2D and 3D ÃR * 2 ÃR * 2 ÃR * 2 

in 2D ÃR * 2 - - 

in 3D - - ÃR * 2 

L & R organ defined* in 2D and 3D ÃL + ÃR ÃL + ÃR ÃL + ÃR 

in 2D ÃL + ÃR - - 

in 3D - - ÃL + ÃR 

L & R organ defined 

& R (or L) organ defined 

in 2D 

in 3D 

ÃL + ÃR ÃR * 2 ÃR * 2 

L & R organ defined 

& R (or L) organ defined 

in 3D 

in 2D 

ÃR * 2 ÃR * 
SPECTFactorL+R 

ÃL + ÃR 

‘Defined’ means that a region was drawn and an activity was segmented in all time points. 

19.6 Density values for mass-to-volume conversion 

Organ Density (g/cm³) 

Blood 1.06 

Brain 1.04 

Breast 1.02 
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Cortical bone marrow, 

Cortical bone mineral surface, 

Cortical bone mineral volume 

1.92 

Eye lens 1.07 

Muscle 1.20 

Lungs 1.05 

Ovaries 1.05 

Testes 1.04 

All other 1.06 

 

19.7 Performance Validation & Accuracy  

QDOSE has undergone extensive verification and validation to confirm its accuracy in estimating 

absorbed dose values. The software was tested against established dosimetry benchmarks, including 

IDAC-Dose 2.1 and Olinda/EXM 1.1, which are widely accepted in the field of nuclear medicine 

dosimetry. 

• Accuracy: The absorbed dose estimates produced by QDOSE showed deviations of 4% for 

critical organs and up to 15% for specific organ dose calculations, which fall within 

clinically acceptable limits. 

• Validation Results: Performance tests using phantom studies and Monte Carlo simulations 

confirm that QDOSE’s volumetric dose calculations have an error margin of <5% in controlled 

test environments. 

• Planar vs. Hybrid vs. Volumetric Workflows: The accuracy across different workflows was 

assessed: 

o Planar workflow: deviation of 1.3% 

o Hybrid workflow: deviation of 0.3% 

o Volumetric workflow: deviation of 0.04% 

• Comparison to Industry Standards: The results were benchmarked against similar dosimetry 

solutions, demonstrating comparable or superior performance in specific dosimetric 

calculations. 

19.8 Reproducibility and Repeatability  

QDOSE ensures consistent results across multiple test scenarios, with validation focusing on inter-

operator and intra-operator variability. 

• Inter-operator variability: Results differ by ≤3% when different users analyze the same 

dataset. 
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• Intra-operator consistency: Repeated dose calculations by the same user yield variations of 

≤2%. 

• Clinical validation: Studies confirm that deviations in dosimetry calculations between different 

implementations remain within the expected 6% for organs and 10% for tumors, confirming 

repeatability in real-world scenarios. 

• Regression testing: QDOSE has undergone software regression testing to ensure consistent 

performance across updates. 

19.9 Limitations and Considerations  

While QDOSE provides highly accurate dose estimations, certain limitations should be considered: 

• Data Quality Dependency: The accuracy of dose calculations is directly affected by the quality 

of input images, scanner calibration, and patient motion artifacts. Users should verify the 

integrity of image data before performing analysis. 

• Voxel S Model Constraints: The Voxel S method is optimized for soft tissues and is not 

validated for bone or lung tissues, where density variations may introduce calculation errors. 

• Alpha Emitter Dosimetry Limitations: The software currently models only the parent nuclide 

in alpha-emitter dosimetry. Daughter nuclides in decay chains are not accounted for, 

leading to possible underestimation of absorbed dose. 

19.10 Software Validation  

QDOSE has undergone extensive verification and validation testing to ensure compliance with 

regulatory and industry standards. 

• Phantom Model Validation: The software was tested using Monte Carlo simulation models 

to verify absorbed dose estimations under controlled conditions. 

• Clinical Dosimetry Comparisons: QDOSE results were benchmarked against patient-specific 

dosimetry data and compared with leading dosimetry tools, confirming accuracy within 

acceptable clinical thresholds. 

• Regulatory Compliance: The software validation process complies with ISO 62304 (Medical 

Device Software – Software Life Cycle Processes) and is aligned with requirements under 

MDR (EU) 2017/745. 
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